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INTRODUCTION TO HOPEX IT BUSINESS 
MANAGEMENT

HOPEX IT Business Management is an Enterprise Architecture solution that helps enterprise
architects:

 manage application portfolios
 design IT solutions aligned with business needs
 plan changes to information systems.

HOPEX IT Business Management complements the application inventory and management
functions of HOPEX IT Portfolio Management, which it integrates by default, with strategic
planning functions.

The purpose of this guide is therefore to present how to make best use of these functionalities for
the successful evolution of your information system.

 Presentation of HOPEX IT Business Management
 Connecting to HOPEX IT Business Management
 Preparing the Work Environment HOPEX IT Business Management
 Using ArchiMate Diagrams in an Enterprise Architecture solution
 About This Guide
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PRESENTATION OF HOPEX IT BUSINESS MANAGEMENT

HOPEX IT Business Management provides the methodology and the tools you
need to plan your business transformation.

Positioning of the HOPEX IT Business Management solution
HOPEX IT Business Management offers a formalism of reflection on the
company's value streams and business capabilities. This solution makes it possible
to define a business transformation strategy divided into phases with clearly
identified objectives and means. At each of these phases, standard reports are
proposed to simplify analysis of the subject and assist in decision-making.

HOPEX IT Portfolio Management
The HOPEX IT Business Management solution includes HOPEX IT Portfolio
Management product that offers the following possibilities:

• Aligning the application assets with business requirements;
• Reducing IS operating costs by removing applications no longer used;
• Managing technologies relating to applications;
• Identifying the business services covered by applications or application 

versions;
• Deciding on investments for maximum profits.

HOPEX Customer Journey
HOPEX IT Business Management includes HOPEX Customer Journey to
represent the acquisition process of a product or a service by a specific customer.
Mapping a customer journey provides an overview of customer expectations,
painpoints encountered, and the resources used at each step of the journey. Last
but not least, touchpoints, which are the points of interaction between the customer
and the company, are used to measure and improve overall customer satisfaction.

 A customer journey is used to describe and organize all service 
interactions between the enterprise and a persona for a given result.

Representing a customer journey will allow you to easily identify these critical
points. HOPEX Customer Journey is used to describe solutions for improvement
and to assess them at different dates.

 For more details on   product, see "The customer journey" chapter 
in the  HOPEX Business Process Analysis guide.
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HOPEX Business Process Analysis
HOPEX Business Process Analysis provides HOPEX IT Business Management
with:

• The description of organizations that implement the business functions 
and/or the business capabilities identified in HOPEX IT Business 
Management;

• The description of organizational processes that implements the value 
streams identified in HOPEX IT Business Management.

HOPEX IT Architecture
HOPEX IT Architecture provides HOPEX IT Business Management with the
possibilities to model the information system architecture according to a number of
analysis perspectives:

• Description of application architecture offers a detailed view of 
information exchanges between applications, services, databases and 
organizational.

• Description of information system technical infrastructure enables 
monitoring of applications deployment on the different enterprise.

• Description of complex systems involving different types of IT and non IT 
resources.

HOPEX IT Business Management provides HOPEX IT Architecture with the
possibilities to support the description, analysis and transformation projects of the
IT system.

HOPEX for the ArchiMate® Framework
HOPEX for the ArchiMate® Framework module complements HOPEX IT
Business Management by describing the environment of certain Enterprise
Architecture building blocks in the ArchiMate® formalism.
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CONNECTING TO HOPEX IT BUSINESS MANAGEMENT

The menus and commands available in HOPEX IT Business Management depend
on the profile with which you are connected.

Connecting to the solution
To connect to HOPEX IT Business Management, see HOPEX Common Features,
"HOPEX Desktop", "Accessing HOPEX (Web Front-End)".

 HOPEX IT Business Management Profiles
The rights of different users on objects depend on their assigned profiles. For more
information on creation of users and assignment of profiles, see the chapter
"Managing Users" in the HOPEX Power Supervisor guide.

In HOPEX IT Business Management, there are default user profiles with which
specific rights and accesses are associated. These profiles are:

• Enterprise architect
• EA functional administrator
• EA Contributor
• EA Viewer

Profile Tasks

Enterprise architect The enterprise architect manages the structure 
of an organization to ensure that IT systems are 
aligned with current business strategies and 
capabilities.

EA functional administrator The EA functional administrator has rights on all 
objects and workflows.
He/she prepares the working environment and 
manages reference data used in the solution.

EA Contributor The EA contributor is responsible for validating 
the design of the objects assigned to him/her.

EA Viewer The EA viewer has read-only rights on objects in 
the repository.
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THE HOPEX IT BUSINESS MANAGEMENT DESKTOP

The menus available in HOPEX IT Business Management depend on the profile
with which you are connected.

For a detailed description of the HOPEX interface, see PLATFORM - Common
Features > HOPEX Desktop > Interface Presentation.

ITBM Home Page
The ITBM solution home page consists of the following sections.

• The header presents some information of general interest. 
 These can be defined in the Administrator’ Administration> 
Methodological Domain menu.

• My priorities: indicates the main strategic themes of interest to 
solution users. 

• Help: points to user documentation and the user community.
• The My Scope provides useful indicators of the repository content. See 

Scope Indicators below.
• The Quick Access provides useful shortcuts:

• Recently viewed: last objects and diagrams accessed by the user
• Favorites: user favorites and shared favorites
• Actions: quick access to the creation of architecture elements. 

• My favorite report: displays the user-defined or administrator-
predefined report, which can be used as an entry point into the 
repository.
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Scope Indicators
The My Scope section provides useful indicators on application assets. Clicking the
indicator takes you to all the corresponding objects. There are three groups of
indicators: 

• Application governance
• Risk and compliance 
• Inventory 

Application governance 

This tile lists the following objects:
• Applications without owners: displays a list of applications to which you 

can assign managers.
 See also Designate People Responsible for Applications.

• Applications lot linked to a portfolio: displays a list of applications to 
which you can link portfolios.

• Applications without exposed exchanges: displays applications that 
neither receive nor send flows. 

 See Specifying Data Exchanged With Other Applications.

• Applications included in a transformation project: these are the 
applications that are part of the deliverables of a transformation project. 

 See Defining the Business Case of a Project.

• Applications not mapped to business capabilities: displays a list of 
applications to which you can link business capabilities.

 See Defining Application Functional Scope.

Risk and compliance

This tile lists the following objects:
• Critical applications: all applications that cover a strategic business 

capability, in other words, whose Business Value is "Significant”.
 This is the business value defined during the last business 
capability assessment. For more details on assessing a business 
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capability, see Using Assessment for Business Capabilities and their 
Implementation.

• Applications with an obsolescence risk: applications whose risk of 
obsolescence is between “Medium” and “Very high”.

 The risk of application obsolescence corresponds to the highest risk 
of the technologies linked to it. See the obsolescence risk in the 
Overview of a technology.

• Applications with sensitive data: applications linked to data stores 
containing data (classes, MD entities, data views) or Concepts in the 
"Sensitive data" category.

 See also: Defining the Data Used by an Application.

• Technologies soon obsolete
• Technologies without lifecycle

Inventory

The Inventory tile displays the number of following objects:
• Applications
• On-premises Applications

 This is the type of application installation. See Application 
identification> Cloud Computing.

• Cloud Applications 
 This is the type of application installation. See Application 
identification> Cloud Computing.

• Technologies
• Microservices

Enterprise Architect Desktop
The HOPEX IT Business Management navigation menus are:

Business function

The Business menu is dedicated to strategic transformation.

See Introduction to strategic transformation.

Applications

The Applications menu shows all the applications in the repository, as well as the
application portfolios.

See Drawing up an Application Inventory.

Technologies

The Technologies menu lets you manage application-related technologies.

See Drawing up a Technology Inventory.
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Data

The Data menu allows you to make an inventory of the conceptual and logical data
exchanged within the application assets.

See Managing the Data Used in the Application Assets.

Tools

The Tools menu gives access to the following submenus:
• SMART Analysis to analyze the business value of portfolio applications 

and their migration to the Cloud.
 See SMART Analyses.

• IT-Pedia to import and standardize technologies in HOPEX.
 See Importing Technologies from IT-Pedia.

• AI-Driven APM, to distinguish technologies from business applications.
 See Distinguishing Applications from Technologies.

• Assessment and data call.
 See Collecting Data for a Set of Applications.

Reports

The Reports menu provides a search tool for all report templates and saved
reports.

 For more details on reports, see PLATFORM - Common Features > 
Documentation > Generating Documentation > Generating Reports.
 For more information on HOPEX IT Business Management 
reports, see Portfolio Analysis Reports and List of Analysis Reports 
Available on Applications and Application Systems.

Projects

The Projects menu is dedicated to transformation project management.

See Introduction to Project Portfolio Management.

Inventories

The Inventories menu gives access to the following subjects, divided into several
themes.

• Business Architecture theme, giving access to the following 
elements:
• business architecture environment

 A business architecture environment represents the relationships of 
a business functional area with its partners.

• Business Functions
 A business function is a conceptual unit of the division of 
responsibilities in an enterprise. It is used to structure the management 
of information processing, energy, and equipment produced or used. 
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Business functions define the skills and the functionalities necessary to 
the enterprise to fulfill its mission.

• Business Partners
 A business partner designates a third-party who is in relation with 
the enterprise within the framework of a given business architecture 
environment. Examples: private sector client, regulatory organization, 
supplier.

• Capabilities theme, giving access to the following elements:
• Functionalities
• Technology Capabilities
• Hardware capabilities

 For more information on technology and hardware capabilities, see 
Describing a Technology Capability Map with HOPEX IT Architecture.

• Software theme, giving access to the following elements:
• IT Services

 An IT service is a software component of an application, that can’t 
be deployed alone and that realizes a sub-set of the functionalities of 
this application either for end users of this application or inside the 
application (or another application). This includes batch programs.
 For more details on applications services, see Describing an IT 
Service with HOPEX IT Architecture.

• Microservices
 A microservice is a software component that can be deployed 
autonomously, but which does not directly provide an end user service. 
It can interact with other application services, applications or application 
systems. This is a deployable software component that uses software 
technologies. For example: an authentication service, a PDF file printing 
service.
 For more details on microservices, see Describing a microservice 
with HOPEX IT Architecture.

• System process 

 A system process is the executable representation of a process. the 
events of the workflow, the tasks to be carried out during the 
processing, the algorithmic elements used to specify the way in which 
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the tasks follow each other, the information flows exchanged with the 
participants.
 For more details on system processes, see Describing System 
Processes.

• Application Hierarchy, to view applications associated with the 
following object types: business line, process category, business 
capability, etc.

• Logical software architecture, to describe the elements contained 
in the information system logical architecture.

 For more details on logical architecture, see Describing Logical 
Application Architecture.

• Technologies theme, giving access to the following elements:
• Technologies Hierarchy, to view technologies associated with the 

following object types: technology capability, technology type, vendor, 
etc.

• Technology Stacks, which are groups of technologies.
 See Defining a Technology Stack.

• Installations theme, to describe application deployment elements.

 A facility is a model of site of interest for the enterprise. Examples: 
Data Center, Factory or Outlet
 For more details on facilities, see Describing a Facility.

• Services Catalogs theme, giving access to the following elements:
• Cloud services

 See Using Cloud Services.

• Technical Services, to list the technical services covered by 
applications.

• Business Services, to list the business services covered by 
applications.

• Hardware Service Catalogs
 For more details on service catalogs, see the“Using Service 
Catalogs" chapter from the HOPEX IT Architecture guide.

• Infrastructure theme, giving access to the following themes:
• IT Infrastructure
• Resource Architecture
• Resource Configuration

Governance

In the Governance menu you can define the regulations to which application
architecture objects are subject.

 In the properties of an application, the Governance page defines 
the regulations to which application is subject. By default, this page is 
hidden, you can display it using the Show/Hide button of the 
application properties.
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Environment

The Environment menu gives access to the following submenus:
• Containers, to access the features of library and environment 

management.
 For more details on Containers and Organization, see Preparing 
the Work Environment HOPEX IT Business Management.

• Organization, to access the main objects processed with the HOPEX IT 
Business Management solution.
• Business lines

 A business line is a high level classification of main enterprise 
activities. It corresponds for example to major product segments or to 
distribution channels. It enables classification of enterprise processes, 
organizational units or applications that serve a specific product and/or 
specific market.

• Process categories
 A process category defines a group of processes. It is linked to a 
Process Map or higher level Process Category. It regroups several 
processes and/or other categorized elements (e.g. Value Streams, 
Applications). It serves as an intermediate categorization level in the 
process hierarchy, so as to provide a guided and progressive access to 
finer grained processes.

• Processes
 A process is a set of operations performed by org-units within a 
company or organization, to produce a result. It is depicted as a 
sequence of operations, controlled by events and conditions. In the 
BPMN notation, the process represents a sub-process from the 
organizational point of view.

• Sites
 A site is a geographical location of an enterprise. Examples: Boston 
subsidiary, Seattle plant, and more generally the headquarters, 
subsidiaries, plants, warehouses, etc.

• Org-Units
 An org-unit represents a person or a group of persons that 
intervenes in the enterprise business processes or information system. 
An org-unit can be internal or external to the enterprise. An internal 
org-unit is an organizational element of enterprise structure such as a 
management, department, or job function. It is defined at a level 
depending on the degree of detail to be provided on the organization 
(see org-unit type). Example: financial management, sales 
management, marketing department, account manager. An external 
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org-unit is an external entity that exchanges flows with the enterprise. 
Example: customer, supplier, government office.
 For more details on the use of Org-units, see Defining Enterprise 
Org-Units.

• Report DataSets
 A Report DataSet is a set of data extracted from the HOPEX 
repository and used as a data source in reports.
 For more information, see Platform - Common Features > 
Documentation > Generating Documentation > Managing Report 
DataSets.

• All Sketches, to access all the skectches of your repository.

 A sketching diagram is a drawing that enables you to exchange 
with your coworkers without an issue of methodology or formalism.
 For more details on the use of sketches with HOPEX IT 
Architecture, see Creating a Sketching diagram with HOPEX IT 
Architecture.

• Tags
 A tag is a classifying description used to characterize objects.

 For more details on the use of tags, see Platform - Common 
Features > Collaboration Tools > Communicating in HOPEX.
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PREPARING THE WORK ENVIRONMENT HOPEX IT 
BUSINESS MANAGEMENT

Inventory and evaluation of the application assets are based on description of
business elements - in order to map business requirements with the application
architectures that serve as their support - as well as organizational elements such
as org-units and deployment sites. 

The following points indicate how to create elements that constitute your working
environment. This step is executed by the Functional Administrator.

Defining Enterprise Org-Units
HOPEX IT Business Management is used to describe the org-units of your
enterprise.

 An org-unit represents a person or a group of persons that 
intervenes in the enterprise business processes or information system. 
An org-unit can be internal or external to the enterprise. An internal 
org-unit is an organizational element of enterprise structure such as a 
management, department, or job function. It is defined at a level 
depending on the degree of detail to be provided on the organization 
(see org-unit type). Example: financial management, sales 
management, marketing department, account manager. An external 
org-unit is an external entity that exchanges flows with the enterprise. 
Example: customer, supplier, government office.

Creating an org-unit
To create an org-unit:

1. Click the Environment > Organization navigation menu.
2. In the edit area, click the Org-Units folder then New > Org-Unit.
3. Enter the name of the org-unit.
4. Click OK.

Specifying org-unit properties
To specify the properties of an org-unit:

1. Click the org-unit to open its Properties window.
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2. In the Characteristics page, in the Org-Unit Type field, select the org-
unit. 
There are several types of org-units:
• An "Accountable" org-unit (for example, Sales Manager).
• A "Generic" org-unit corresponds to a role to be played during a 

project (for example, Writer, Requester).
• A "Structure" org-unit (for example, Sales Management).
• A "Function" org-unit (for example, Sales Engineer).

 You can also specify its details (company name, e-mail address, 
telephone number, etc.).

Defining Categorization Schemas
Several categorization schemas can be proposed:

• Data categories,
• Measure Schemes Categorization.

Data categories
HOPEX IT Business Management Solution enables data classification using data
categories.

 For more information on Data Categories see the HOPEX Data 
Governance guide.

To access the list of data categories from the Administration navigation menu:
 Select Categorization Schemas and unfold the Data Categories.

The list of the repository data categories appears.

To create a data category from the Administration navigation menu:
1. Select Categorization Schemas.
2. Select the Data Categories folder and click New > Data Category.
3. Enter the Name of your data category well as its Owner and click OK.

The new data category appears in the list.

To connect a data to a data category :
1. Open the Entities property page.
2. Select the tab that corresponds to the data you want to classify.
3. Click the Connect button ans select the data that interests you.

Measure Schemes Categorization
The Measurement Schemes allow you to define measurement systems specific to
the area you want to deal with.

For example: the “Retail bank” schema or the “investment bank” schema.
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The Measurement Schemes are principally based on:
• Flow Measures provide a way to define parameters of the flows described 

in the flow scenario using les Measurement Types, 
• The Qualifying Values and Measurable Properties are used to define 

performance constraints that must be complied with by the enterprise 
plan.

Flow Measure and Measurement Type

Flow Measures provide a way to define parameters of the that are used described
in the scenario of flows.

 An application flow represents the use of a flow between two 
agents (e.g., applications) in a usage context (represented by a 
scenario of flows). An application flow is based on a flow, which 
represents the reference flow in context.
 For more information message flow scenarios, see chapter “Using a 
Scenario of Application Flows diagram” chapter in the HOPEX IT 
Architecture guide.

A Flow Measure is characterized by Flow Measure Type.

A Measurement Type is defined by several item types:
• Measurement types,
• Flow Measure types, which are defined by a set of Flow measures.
• Technical flow measure types, which are defined by a set of Technical 

flow measures.

Measurable Properties and Set of Constraining Properties

The nature of a Qualifying Value is defined by a Measurable Property. 
 A measurable property expresses the nature of indicators 
(duration, mass, cost, etc.) and defines the unit used to measure them 
(minutes, kilograms, euros, etc.). Measurable properties are used to 
define indicators, they can be elementary or composite. Elementary 
measurable properties are described by measurement units: kg, Liter, 
Gallon, Hour, Minute.

A Set of Constraining Properties is a set of Measurement Types  used to define the
performance constraints that must be complied with by the building blocks making
up the enterprise, at the forefront of which are the business capabilities and the
exhibited business capabilities in a transformation stage.

For example: “Security” or “Performances” measurement types

A Set of Constraining Properties is defined by different component types:
• Sets of Constraining Properties,
• Measurable Properties, 
• Flow Measure types, which are defined by a set of Flow measures.
• Technical flow measure types, which are defined by a set of Technical 

flow measures.
 For more details on Sets of Constraining Properties, see Using 
performance indicators.
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Defining the Process Categories
APQC proposes standard repositories of process categories specific to each major
activity sector.

 A process category defines a group of processes. It is linked to a 
Process Map or higher level Process Category. It regroups several 
processes and/or other categorized elements (e.g. Value Streams, 
Applications). It serves as an intermediate categorization level in the 
process hierarchy, so as to provide a guided and progressive access to 
finer grained processes.

A set of standard process categories repositories from APQC is supplied with HOPEX
IT Business Management. 

If you want to use APQC process categories for the different activity sectors, you
can also import the corresponding libraries.

To import the APQC libraries, see the chapter "Prerequisites to using APQC libraries"
of the HOPEX Business Process Analysis guide. 

To access process categories of your enterprise:
1. Click the Environment > Organization navigation menu.
2. Expand the Process Categories folder.
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USING ARCHIMATE DIAGRAMS IN AN ENTERPRISE 
ARCHITECTURE SOLUTION

HOPEX for the ArchiMate® Frameworkproduct provides facilities to use the set
of concepts defined by the Open Group for ArchiMate® 3.1. ArchiMate® concepts
are mapped with HOPEX Enterprise Architecture building blocks so as to manage
compatibility and continuity with other models.

 For more details on HOPEX for the ArchiMate® Framework 
implementation, see The HOPEX MetaModel for ArchiMate.

Depending on the licenses you have, you can use the ArchiMate® formalism to build
sketchs that represent the models of your enterprise architectures. These sketches
can then be used by associating their elements with objects in your repository.

Note that the ArchiMate® diagrams thus constructed are linked to models and views
in accordance with ArchiMate® standards.

 For more details on the relationship between the elements of 
ArchiMate diagrams and the elements of used  in HOPEX solution, see 
Synchronizing an ArchiMate model Elements.

Prerequisites to use of ArchiMate diagrams
ArchiMate Diagrams can be accessed from an Enterprise Architecture Building Block
if you are authorized to:

• Use an Enterprise Architecture such as: HOPEX IT Architecture, or 
HOPEX IT Portfolio Management or HOPEX IT Business 
Management.

• HOPEX for the ArchiMate® Framework module access.

To use HOPEX for the ArchiMate® Framework, you must import the ArchiMate
module in your environment and the PPM module in each HOPEX repository of the
environment.

To import a module in HOPEX, see Modules > Importing a Module into HOPEX
documentation.

 You must import the ArchiMate module only once even if you 
have several repositories.
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Using ArchiMate Diagrams in an Enterprise Architecture solution
To simplify use of ArchiMate® formalism in an HOPEX Enterprise Architecture
solution, the following facilities are offered to you when creating an ArchiMate
diagram from an EA Buiding Block:

• Modeling an object in the ArchiMate® formalism, see Creating an 
ArchiMate Diagram from an EA Building Block.

• Management of the ArchiMate® model associated with the described 
object, see Management of the ArchiMate model in an Enterprise 
Architecture solution.

• Management of the ArchiMate® view associated with the described 
object, see Managing of the ArchiMate views in an Enterprise 
Architecture solution.

• For more details on the relationship setting of an ArchiMate diagram 
items with the repository building blocks, see Synchronizing an 
ArchiMate Diagram Elements.

The Architecture Building Blocks (EA building blocks) from which you can create an
ArchiMate diagram are:

• Enterprise,
• Processes
• Application System
• Application
• Microservice,
• Software Installation,
• IT infrastructure,
• Facility,
• Project.

Creating an ArchiMate Diagram from an EA  Building Block
With ArchiMate® framework, a diagram is created in the context of a Model and a
View. When an ArchiMate diagram is created from an EA building block, the
following actions are done:

• If no model has been defined for the user, an ArchiMate Model is 
automatically created. For more details, see Management of the 
ArchiMate model in an Enterprise Architecture solution,

• An ArchiMate® View is automatically created and connected to the 
described object. For more details, see Managing of the ArchiMate views 
in an Enterprise Architecture solution.

• If the type of the described object correspond to an ArchiMate type, an 
ArchiMate® element is automatically created with the same type. The 
new ArchiMate® element is associated to the described object. For more 
details, see Synchronizing an ArchiMate Diagram Elements.

For example, to create an ArchiMate Diagram from an application:
1. From the Applications navigation menu, select the application of 

interest to you and click Create a diagram.
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2. In the selection window, click ArchiMate Diagram.
The diagram opens in the edit area. The ArchiMate component associated
to the application is created and inserted in the diagram. 

 The created ArchiMate component is connected to the ArchiMate 
Model, see Management of the ArchiMate model in an Enterprise 
Architecture solution.
 The created ArchiMate diagram is connected to the ArchiMate View, 
see Managing of the ArchiMate views in an Enterprise Architecture 
solution.

Creating an Object in the ArchiMate diagram of an EA Building Block
To create an Application component, for example:

1. In the diagram insert toolbar, click the Application component button. 
2. Click in the diagram.

The adding window opens.
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3. Enter the name of the new element.
A message confirms that no objects match this name.

4. Click Create.
The Application component appears in the diagram with the specified
name.

Adding an existing object in the ArchiMate diagram of an EA Building Block
To add an existing object to an ArchiMate diagram, you can drag and drop the object
from a hierarchical view or from the insert toolbar of the diagram.

To add an Application component, for example, using the insert toolbar of an
ArchiMate diagram:

1. In the diagram insert toolbar, click the Application component button. 
2. Click in the diagram.

The adding window opens.
3. In the object name box, click the down arrow.

The list of the model Application components is displayed.
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4. Enter the name of the element you wish to create.
The application component appears in the diagram with the specified
name.

 You can select several components. Each one will be added to the 
diagram.

Creating a relationship in an ArchiMate Diagram 
In an ArchiMate diagram a link corresponds to an ArchiMate@ Relationship. 

A Relationship can be created with the Link button of the the diagram insert toolbar.
When you select the link button, a dialog box opens to display the available
relationship types.

 For more information on ArchiMate@ Relationship types, see 
ArchiMate Relationships.

ArchiMate element properties in an EA solution
The Characteristics properties of an ArchiMate element provides access to several
sections.

• The Identification section provides access to the following information:
• the Name 
• its Owner, by default, the Model associated to the current diagram.
• The EA building block is the repository building block connected to 

the ArchiMate element.
• the text of its Description.

 For more details on links between the repository building blocks 
and the ArchiMate elements, see Synchronizing an ArchiMate Diagram 
Elements.

• The ArchiMate Views  section provides the list of views describing the 
object.

The Diagram properties of an ArchiMate element provides access to the diagrams
containing the element and can be used to create a new one.
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The Reporting properties of an ArchiMate element provides access to the ArchiMate
Element Graph representing the relationships between the current element and the
model elements.

Management of the ArchiMate model in an Enterprise Architecture 
solution

The ArchiMate model is the ArchiMate elements root; a model provides access to the
folder describing views anf elements. 

 For more details, see Using HOPEX for the ArchiMate Framework 
Folders.

Accessing ArchiMate Models list in an Enterprise Architecture solution
To access the list of ArchiMate models:

 From the Environment navigation menu, select ArchiMate Models.
The list of models is displayed as an object tree.
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The functionalities proposed from the navigation menu Environment > ArchiMate
Models are the functionalities proposed in the HOPEX product.

 For more details on how to use HOPEX for the ArchiMate® 
Framework solution, see Starting with HOPEX for the ArchiMate 
Framework.

ArchiMate Models properties
The Characteristics properties of an ArchiMate model provides access to several
sections.

• The Identification section provides access to the following information:
• the Name 
• the Owner. by default the current library.
• the text of its Description.

• the Persons sections provides the list of persons (System) using this 
model as the default one. See Defining the default ArchiMate Model for a 
user.

• The EA Elements section providing the list of EA Elements owned by the 
model. See The Characteristics properties of ArchiMate® EA Elements 
enable the mapping of shared inventory objects..

• The Standalone Elements section providing the list of standalone 
Element owned by the model. See The Characteristics properties of 
ArchiMate® EA Elements enable the mapping of shared inventory 
objects..

• The Views section providing the list of Views owned by the model. See 
Managing of the ArchiMate views in an Enterprise Architecture solution.

• The Sub-Folders section providing the list of Sub-Folders owned by the 
model. See Managing of the ArchiMate views in an Enterprise 
Architecture solution.

Defining the default ArchiMate Model for a user
When an ArchiMate diagram is created from an EA building block,  an ArchiMate
model is automatically created if no default ArchiMate model is defined for the user.

To assign a default ArchiMate model to a user:
1. From the Environment navigation menu, select ArchiMate Models.

The list of models appears.
2. Open the Characteristics properties of the model that interests you and 

expand the Persons section.
3. Connect the user to the model.

 If a default model is already connected to a user, the current model 
will replace the previous one.
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Managing of the ArchiMate views in an Enterprise Architecture 
solution

In accordance with ArchiMate® standards:
• A Viewpoint specifies the list of concepts (elements and relationships) 

mandatory in a specific View type.
• A new View is created depending on a specific Viewpoint in an 

ArchiMate® model context.
 For more details on the types of the elements associated to a 
Viewpoint, see The properties of a viewpoint.

When an ArchiMate diagram is created from an EA building block, the corresponding
view is automatically created from “Layered” viewpoint.

 To access the list of views associated the an EA Building block: 
open the ArchiMate Views properties of the object.

Accessing ArchiMate Views list
To access the list of  Views associated to an ArchiMate model:

1. From the Environment navigation menu, select ArchiMate Models.
2. Expand the folder of the model that interests you.
3. Expand the Views folder.

The list of Views appears.

ArchiMate Views properties
In the Characteristics properties of an ArchiMate View, the Identification
section provides access to the following information:

• the Name 
• its Owner, by default the ArchiMate model associated to the View.
• the text of its Description.
• the Viewpoint,
• its Status.

Synchronizing an ArchiMate Diagram Elements
ArchiMate® concepts are mapped with HOPEX EA building blocks enabling
compatibility and continuity with other models. Thus, an ArchiMate Business Process
can reference a Process which can be described in a BPMN diagram, so that the user
can navigate from an overview ArchiMate diagram putting a process into its EA
context, to a more detailed BPMN description.

 For more details on HOPEX for the ArchiMate® Framework 
implementation, see The HOPEX MetaModel for ArchiMate.

The synchronization consists in mapping an ArchiMate element created in the
context of an ArchiMate diagram with an EA building block.
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Two possibilities are provided to synchronize an ArchiMate element:
• In a unitary manner by opening the Characteristics properties of an 

ArchiMate Element, see Synchronizing an ArchiMate model Elements.
• Generally using the Synchronize button of an ArchiMate diagram, see 

Synchronizing Elements from an ArchiMate diagram using the 
synchronization wizard.

Synchronizing an ArchiMate model Elements
 For more details on ArchiMate® elements mapping with HOPEX 
MetaClasses, see Concepts mapping.

The HOPEX for the ArchiMate® Framework solution provides two types of
element:

• The ArchiMate® EA Elements which can be associated to a repository 
object.

 For more details, see Synchronizing an ArchiMate Diagram 
Elements.

• The  Flow type Relationships whose sender and receiver are 
synchronized with the ITPM “flows” between applications.

 For more details, see ArchiMate Relationships.

Mapping an ArchiMate® EA Element to an HOPEX object in 
properties

 For more details on HOPEX for the ArchiMate® Framework EA 
Elements, see Synchronizing an ArchiMate Diagram Elements.

To synchronize an Application component, for example:
1. Open the Characteristic property page the Application Component you 

are interested in.
2. In the Identification section, from the EA building block field, click 

the right arrow and click the Connect button.
 The name of the field depends on the type of the selected 
ArchiMate Element.

A connection window opens.

3. Select the type of the EA building bock you want to connect to the 
Application component.
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4. Select the repository instance you want to connect to the Application 
component.

Synchronizing Elements from an ArchiMate diagram using the 
synchronization wizard

From an ArchiMate diagram, you can synchronize all the elements of the diagram
which have a possible mapping to HOPEX objects, or create new corresponding
HOPEX objects of the relevant type.

This enables to reference existing Building Blocks in HOPEX inventories used by
other solutions (e.g., Processes from HOPEX Business Process Analysis or
Applications form HOPEX IT Business Management).

To synchronize a Device, for example:
1. Open the diagram in edit mode.
2. Click the Synchronize button.

A window opens and shows a table of all the elements of the diagrame.
The Building Block column allows the synchronization of the diagram
elements.

3. Click the Building Block box of the element that interests you.
 In a case of a “multiple” mapping, you may   choose the type of the 
associated repository object. For more details, see Mapping an 
ArchiMate® EA Element to an HOPEX object in properties.

• If the item is already mapped or synchronized, "Mapping already 
exists" or "Element synchronized" message appears in the 
Synchronization status cell.

• If no item of the default type with the element name is found, then 
"No match" is displayed in the Synchronization status cell.

• If one item of the default type with the element name is found, then 
then "one match" is displayed in the Synchronization status cell.

• If many items are found, click on the Building Block cell to select the 
appropriate one (the context is given by the owner / long name).

• When you want to create a new building block of a different type than 
the default one, check the Create new building block box and select 
the desired type in the Type cell.

4. Click Next.
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5. The list of Flow type Relationships with synchronized sender and 
receiver is displayed.

6. An EA flow is created between the repository EA objects if the box in the 
ArchiMate Relationships Synchronization column is checked.

7. Click OK.

Once ArchiMate® EA Elements are mapped to HOPEX Building Blocks, the
navigation to these objects is possible via the ArchiMate® EA Elements
properties.

Reaching these objects describing diagrams can be achieved:
• through the Diagrams properties of the referenced objects,
• Using Diagrams containing objects feature from:

• the ArchiMate® EA Element Diagrams properties
• using the object pie menu in a diagram preview.
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ABOUT THIS GUIDE

This guide explains how to make best use of HOPEX IT Business Management to
ensure efficient management of your Business Architecture projects.

Guide Structure
The guide HOPEX IT Business Management is divided into two parts consisting
of the following chapters:

• concerning the strategy part
• Business capability maps and value streams; explains how HOPEX IT 

Business Management helps you in analyzing the business 
capabilities of your enterprise to check their suitability with your 
business functions and your skills.

• Identifying Strategic Transformation Elements; describes how the list 
of drivers specified to assess them in order to refine the list of 
transformation strategic goals of the enterprise.

• Drawing the Transformation Roadmap; explains how to identify and 
plan the transformation stages necessary to acquire the business 
capabilities used to reach the enterprise goals.

• Concerning the portfolio management
• Drawing up an Application Inventory: presents functionalities 

proposed by HOPEX IT Portfolio Management to identify and 
characterize application assets.

• Evaluating Application Assets: introduces the portfolio concept 
available in HOPEX IT Portfolio Management and explains how to 
evaluate applications during the inventory phase. This chapter also 
describes the project concept on which the transformation phase of 
the application assets relies.
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Additional Resources
This guide is supplemented by:

• the  HOPEX Common Features guide describes the Web interface and 
tools specific to HOPEX solutions.

 It can be useful to consult this guide for a general presentation of 
the interface.

• The  HOPEX Business Process Analysis guide, which describes the 
functionalities proposed to manage processes;

• The  HOPEX IT Architecture guide, which describes the functionalities 
proposed IT systems;

• The  HOPEX Project Portfolio Management guide describes the 
functionalities proposed to manage your portfolio projects;

• The  HOPEX Digital Transformation Desktop guide, which describes 
how to use the Enterprise Architecture HOPEX  solutions in a dedicated 
working environment;

• The  HOPEX Assessment guide, which describes functions proposed by 
HOPEX to use and customize assessment;

• the HOPEX Power Supervisor administration guide.

Conventions used in the guide

 Remark on the preceding points.

 Definition of terms used.

 A tip that may simplify things.

 Compatibility with previous versions.

 Things you must not do.

Commands are presented as seen here: File > Open.

Names of products and technical modules are presented in bold as seen here:
HOPEX.

Very important remark to avoid errors during an operation.
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INTRODUCTION TO STRATEGIC 
TRANSFORMATION

HOPEX IT Business Managementprovides the tools to transform IT architecture, based on the
analysis of business capabilities. 

Business Architecture helps managers define the operating architecture to remain in compliance
with their Business Model and adapt to changes in their economic and regulatory environment.
HOPEX IT Business Management is thus a key tool for enterprise transformation.

The method offered by HOPEX IT Business Management is used to take into account the
enterprise strategy: from driver analysis to the definition of objectives and action resources.
HOPEX IT Business Management also constitutes an analysis solution for enterprise business
capabilities to ensure the services it plans to provide.

Last but not least, HOPEX IT Business Management is combined with other HOPEX solutions
dedicated to the enterprise architecture used to define organizational, application or infrastructure
building blocks.

The following points are covered here:

 The HOPEX IT Business Management method
 Before starting with the strategic transformation
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THE HOPEX IT BUSINESS MANAGEMENT METHOD

The method described in this guide is represented in the steps below.

Identifying Strategic Transformation Elements
This step consists in defining the enterprise transformation goals and identifying the
associated means (Strategies and tactics) to be implemented. The means are
specified in the enterprise transformation stages. 

 For more details about exhibited business capabilities, see  
Identifying Exhibited Business Capabilities.

Value Streams and Business Capabilities description
This step consists in drawing up the elements that provide value to the enterprise
(using value streams) and how the enterprise can deliver those elements (using
business capabilities). For a business capability, you can identify the associated
functionalities and the components that implement them. 

 For more details on this  step, see Describing the Enterprise 
Capabilty for Creating value.

Each transformation stage highlights Exhibited Business Capabilities.
 An exhibited business capability is exhibited by an Enterprise Stage 
with quantified measure (KPI) and potential geopolitical scope (Site) for 
a defined market segment (Business Partner).

For an exhibited business capability, you can identify the measurable properties of
interest for the capability which are used to assess business value and performance
(e.g.: for a delivery capability, we are interested in the "delivery time" expressed in
minutes). The components that implement the exhibited capability are thus
identified and are concerned by the transformation.

 For more details about exhibited business capabilities, see  
Identifying Exhibited Business Capabilities.

Defining the enterprise architectures
This work, performed during the transformation stages, can be done using HOPEX
IT Business Management with other Enterprise Architecture solutions. This
consists of identifying and describing the solution building blocks that contribute to
the exhibited business capabilities implementation. The additional solutions of the
HOPEX platform are used to describe in more detail your models (organizational,
application and technological solution building blocks).

 For more details on solution architectures, see Describing the 
Enterprise Architecture.
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Consulting the transformation roadmap
Reports are provided to help you to analyze and reviewing the transformation
stages of your enterprise.

 For more details on the road map, see  Consulting the 
Transformation Roadmap.

Defining the Transformation Strategy
After having described the current state and analyzing the suitability between the
business capabilities of the enterprise and value architecture elements, this step
consists in drawing up the list of needs for change (or driver) identified at the
various levels by the stakeholders (or interested parties), and assessing them in
order to establish the list of enterprise goals.

 A goal tends to be longer term, and defined qualitatively rather 
than quantitatively. It should be narrow-focused enough that goals can 
be defined for it.

Defining the enterprise and its evolution in time
An enterprise is described by the following elements:

• a business capability map,
• value streams,
• goals and strategies of the transformation,
• Transformation stages which define the concrete implementation of the 

transformation.
 A Business Transformation Stage is a kind of Enterprise 
Transformation Stage aiming at the alignment of the enterprise 
business operating model to its business strategy and corresponding 
exhibited business capabilities (business model).
 For more details, see Creating an Enterprise.

Identifying transformation strategic elements
This step consists of identifying the strategic elements that meets the
transformation drivers. 

 For more details, see Defining Enterprise Strategic Elements.
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An enterprise diagram is used to describe the links between the strategic elements
(goals, strategies, tactics and transformation stages).

 For more information on this diagram, see Building an Enterprise 
Diagram.

Describing the Enterprise Capabilty for Creating value

Describing the Architecture of Business Capabilities

Building the business capability map

A business capability map describes what the enterprise is capable of producing for
its internal needs or for meeting the needs of its clients.

 A business capability map is a set of business capabilities with their 
dependencies which define a framework for an enterprise stage.

 A business capability represents a specific ability that an 
organization possesses or needs to develop to deliver a particular 
business outcome.
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The business capability map thus presents the business capabilities of the highest
level for one of the transformation stages.

 For more details on business capability map diagrams, see Creating 
a capability structure diagram.

Describing the business capability breakdown

Business capabilities are then described more precisely to identify:
• a more detailed granularity capability breakdown;
• the expected effects of the capability;
• the business skills or functionalities required for each of them;
• the dependencies between capabilities (expected effect of one dependent 

from the result of the other).
For example, the business capability that consists of 
managing operations is broken down into a number of business 
capabilities: “Handle customer complaints”, “Manage 
reservations”. 
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Defining the business skills and functionalities associated with 
business capabilities

To be able to then check that each business capability is correctly implemented by
suitable solution building block, you must define the required business skills and
functionalities.

 A technology capability is the ability to deliver a technology service 
which is required by a technology artifact or an application.
 For more details on skills and the business capability functionalities, 
see Defining business skills and functionalities associated with 
capabilities.

Describing value streams
A value stream is represented by a sequencing of value creation steps managed by
the business functions of the architecture.

 A value stream is an end-to-end collection of Value Stages that 
creates an outcome for a customer, who may be the ultimate customer 
or an internal end-user of the value stream.

 A value stage is a distinct, identifiable phase or step within a value 
stream that has a unique entrance criteria, exit criteria, and identifiable 
participating business function or business functional area.

The following diagram presents an example of a value stream: 

 For more details on value streams, see Describing Value Streams.
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Describing business capability implementation by the business functions
This involves connecting the business capability, which corresponds to what we
know how to do or what we want to do and which represents the goal to be
achieved, to a way of achieving what is represented by a business function or a
business functional area at a conceptual level, that is, upstream of organizational
and technical choices.

 A Business functional area is a set of business functions and their 
associated value streams on the conjunction of two main criteria: their 
need in accomplishing one or more business capabilities and the 
common skills and functionalities required to accomplish these business 
capabilities.

This business functional area will itself carry the value processes whose steps will
require its business function components.

Construction of the business capability map on the one hand and the business
architecture environment on the other hand is used to check that the business
capabilities are implemented by the business functions.

 For more details on the businesses associated with business 
capabilities, see Creating Fulfillment of a Business Capability.

HOPEX IT Business Management provides a report that presents the result of
the implementation of business capabilities by business functions.

 For more details on the breakdown of business capabilities, see 
Creating Fulfillment of a Business Capability.

Identifying Exhibited Business Capabilities
 An exhibited business capability is exhibited by an Enterprise Stage 
with quantified measure (KPI) and potential geopolitical scope (Site) for 
a defined market segment (Business Partner).

From a transformation stage, it is possible to create  exhibited business capabilities
that can connect the transformation strategic elements to the technical or
organizational elements that assure their implementation.

 For more details on exhibited business capabilities creation, see 
Managing Exhibited Business Capabilities.

The exhibited business capabilities are assessed with respect to different criteria or
measurable properties.

For example, the competitiveness of a delivery capability 
is measured according to the  ‘delivery time at  target 
cost’ measurable property. 

These measurable properties give rise, for a given transformation stage, to key
performance indicators.

For example, a delivery capability can have a target of 
'delivery time in less than 48 hours for a cost price less 
than 10% of the sales price' within the framework of a given 
transformation stage.

 A set of constraint values defines the grouping of elementary 
Qualifying values that should be examined together in order to 
appreciate the actual performance of a KPIed item. E.g.: a delivery 
must take place in less than 20 minutes and cost less than 5 euros.
 For more details, see Using performance indicators.
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Describing the Enterprise Architecture
Business capabilities are implemented by components of the enterprise
architecture. Technical and functional architectures may be described using
different formalisms:

• by a business function architecture environment, which contains the 
elements that define the enterprise model (operating model) for the 
current stage.
• the definition of the ecosystem of the enterprise (interactions with 

partners), 
• the business function architectures,
• the business functions.

• By the solution building block environments that depend on product 
licenses used, for example,  with HOPEX IT Architecture : the 
environment for Logical Application Systems, the environment for 
Application Systems, the environment for Resource Architectures, etc.

 For more details, see Describing an Enterprise Architecture.

Describing the business architecture environment
 A business architecture environment represents the relationships of 
a business functional area with its partners.

In this example, the business function architecture 
environment of company is made up of the historical business 
function architecture and its interactions with external 
partners: clients and suppliers. You can see in the diagram 
that delivery is outsourced  to a third party deliver 
partner. 

 An application deployment architecture describes one possible 
deployment configuration of an application. It contains the deployment 
architectures to be hosted, recommends hosting architectures and 
identifies required communication techniques (communication protocols 
and port numbers) they use to communicate with each other. . An 
application may have several deployment architectures (E.g.: 
autonomous installation, horizontal or vertical deployment, etc.)

 A business partner designates a third-party who is in relation with 
the enterprise within the framework of a given business architecture 
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environment. Examples: private sector client, regulatory organization, 
supplier.

Communications between the objects are represented by interactions service.
 A Service Interaction represents an interaction for service purpose 
between entities in a specific context inside or outside a company. 
These entities can be enterprise org-units, applications, activities or 
processes, as well as external org-units. The content of this interaction 
is described in a service interface.

Describing a business functional area
 An application deployment architecture describes one possible 
deployment configuration of an application. It contains the deployment 
architectures to be hosted, recommends hosting architectures and 
identifies required communication techniques (communication protocols 
and port numbers) they use to communicate with each other. . An 
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application may have several deployment architectures (E.g.: 
autonomous installation, horizontal or vertical deployment, etc.)

In this example, the history functional area is based on the 
business functional areas for selling, delivering and 
command.

Defining the business skills and functionalities associated with 
business functions

To be able to subsequently check that each business capability is implemented by a
suitable business function, you must define the required business skills and
functionalities, for each business function.

 A technology capability is the ability to deliver a technology service 
which is required by a technology artifact or an application.
 For more details on skills and the business capability functionalities, 
see Defining business skills and functionalities associated with 
capabilities.
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 Consulting the Transformation Roadmap
The transformation roadmap is presented in the form of a report that can be
accessed from the Enterprise property page.

 For more details on transformation plans, see Drawing the 
Transformation Roadmap.
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BEFORE STARTING WITH THE STRATEGIC TRANSFORMATION

Defining a Work Context
 For more details on managing your work context, see the 
"Enterprises and Libraries" chapter in the HOPEX Common Features 
guide.

A library and an enterprise are used to represent a unique work context.

In the context of the HOPEX IT Business Management solution, a library can hold
all the elements of your project: processes and org-units, for example.

 Libraries are collections of objects used to split repository content 
into several independent parts. They allow creation of virtual partitions 
of the repository. In particular, two objects owned by different libraries 
can have the same name.

An Enterprise is used to represent the work context of a transformation project.
 An Enterprise is a purposeful undertaking, conducted by one or 
more organizations, aiming at delivering goods and services, in 
accordance with the enterprise mission in its changing environment. 
During its development over time, an enterprise has to adapt to its 
environment and sets up transformation goals and objectives along with 
course of action to achieve these objectives. The design and realization 
of the resulting transformation stages may transcend organizational 
boundaries and consequently require an integrated team working under 
the direction of a governing body to involve stakeholders in 
transformation initiatives. This requires the implementation of an 
integrated team, under the responsibility of a governing body, to 
involve the stakeholders in the transformation.

Accessing the list of libraries with HOPEX IT Business Management
To access the list of libraries from the Environment navigation menu:

 Select Containers > Libraries.
The library tree appears.

 For more details on libraries, see “Using libraries” chapter in the  
HOPEX Common Features guide .

Using Properties Pages 

HOPEX IT Business Management provides properties pages available for several
solutions.

 Using the facilities described in the HOPEX Power Studio guide, 
you can customizing the properties pages of your solution.
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The pages below are common to main HOPEX IT Business Management objects.
• the Measurable Property  is used to access to:

• the Measurable Property section which provides the list of 
measurable properties associated to the described object.

• the Set of Constraining Properties section which provides the list of 
Sets of constraining properties associated to the described object.

 For more details, see Using performance indicators.

• The Implementation page provides access to the list of Enterprise 
Architecture solution building blocks that implement the described 
object.

 For more details on implementation of business capabilities, see 
Describing Component Fulfillment.

• The Reporting page provides access to the reports available for the 
described object.

Importing an Existing Breakdown of Business capabilities
HOPEX IT Business ManagementUse Excel data exchange wizards to export
import and breakdowns of business capabilities. The Excel Template is Business
Capabilities Template.xlsx.

 For more details on Excel data exchange wizards, see the 
“Exchanging Data with Excel” chapter in the HOPEX Common 
Features guide.
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Structure of the import/export Excel template of HOPEX IT Business 
Management

The Business Capabilities Template.xlsx Excel template of HOPEX IT Business
Management allows you to import a breakdown of business capacities and a
breakdown of functionalities.

• At the level of business capabilities, the elements are as follows:
• Business Capabilities

 A business capability represents a specific ability that an 
organization possesses or needs to develop to deliver a particular 
business outcome.

• Business capability maps

 A business capability map is a set of business capabilities with their 
dependencies which define a framework for an enterprise stage.

• Business capability components, which define the link between a 
business capability and the business capability map (or business 
capability) in which it is referenced.

• Business Capability fulfillments, which define the link between a 
business capability and the application that implements it.

• At the level of functionalities, the elements are as follows:
• Functionalities

 A technology capability is the ability to deliver a technology service 
which is required by a technology artifact or an application.

• Functionality maps

 A technology capability map is a set of technology capabilities and 
their dependencies that, together, defines the scope of a hardware or 
software architecture.

• Sub-functionalities, which define the link between a functionality and 
the functionality map (or the functionality) in which it is referenced.

• Functionality fulfillments, which define the link between a functionality 
and the application that implements it.

• Applications, which here represent the supports for implementing 
business capabilities or functionalities.

 An application is a software component that can be deployed and 
provides users with a set of functionalities.
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The information contained in the Excel template delivered with HOPEX IT
Business Management is presented as follows: 

• One page per element type: Business capability, Business capability 
map, Functionality, Functionality map, Application, ...

• For each element of Business capability, Business capability map, 
Functionality, Functionality map or Application type:
• Short Name : name of the object concerned.

• For each element of Business capability component (or Sub-
functionality) type:
• Business Capability Building Block (or Owner Functionality 

Building Block): name of the composite object (business capability 
map, for example).

• Business Capability Used (or Sub-functionality): Name of the 
component object.

• For each element of Business Capability fulfillment (or Functionality 
fulfillment) type:
• Fulfilled Business Capability (or Fulfilled Functionality): name of 

the implemented business capability (or functionality).
• Realizer Agent (or Fulfilling Enterprise Articfact): name of the 

application that implements the capability or the functionality.
• Short Name : name of the object associated with the 

implementation.

Importing the breakdown of business capabilities into an enterprise
Several steps must be followed in order for the Excel import of a business capability
breakdown to be performed correctly:

1. Advanced Options and Settings of Excel Wizards,
2. Specifying the current library,
3. Exporting data from your repository with HOPEX IT Business 

Management,
4. Exporting data from your repository with HOPEX IT Business 

Management,
5. Importing the new import Excel file in your repository.

 For more details on Excel Import wizards, see the “Importing Data 
with Excel” chapter in the HOPEX Common Features guide.

Specifying the current library

A library and an enterprise are used to represent a unique work context.
 Libraries are collections of objects used to split repository content 
into several independent parts. They allow creation of virtual partitions 
of the repository. In particular, two objects owned by different libraries 
can have the same name.

In order for the data you import with Excel to be linked to a specific library, you must
specify the current library. 

To set the current library:
1. Click the Environment navigation menu then Containers > Libraries.
2. Expand the Libraries tree.
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3. Right-click the library that interests you to open its pop-up menu and 
select Set As Default.
The selected library becomes the current library.

Exporting data from your repository with HOPEX IT Business 
Management

If you want to export business capability maps or functionality maps that exist in
another repository than your current one, for example, you can use the Excel
template of HOPEX IT Business Management.

 For more details on Excel Export, see the “Exporting Data with 
Excel” chapter in the HOPEX Common Features guide.

When the Excel file is filled with the names of the objects you want to import, you
must complete the necessary information for import into HOPEX IT Business
Management.

 For more details, see Structure of the import/export Excel template 
of HOPEX IT Business Management.
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IDENTIFYING STRATEGIC TRANSFORMATION 
ELEMENTS

This stage consists of drawing up a list of strategic elements for the enterprise's transformation.

You can access all the strategic elements of your enterprise and its transformation stages from the
Business > Strategic Planning navigation menu. The enterprise and its transformation stages
appear in the form of a tree. 

The following points are covered here :

 Enterprise Strategic Elements,
 The strategic elements of a transformation phase,
 Using performance indicators.
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ENTERPRISE STRATEGIC ELEMENTS

 An Enterprise is a purposeful undertaking, conducted by one or 
more organizations, aiming at delivering goods and services, in 
accordance with the enterprise mission in its changing environment. 
During its development over time, an enterprise has to adapt to its 
environment and sets up transformation goals and objectives along with 
course of action to achieve these objectives. The design and realization 
of the resulting transformation stages may transcend organizational 
boundaries and consequently require an integrated team working under 
the direction of a governing body to involve stakeholders in 
transformation initiatives. This requires the implementation of an 
integrated team, under the responsibility of a governing body, to 
involve the stakeholders in the transformation.

The strategic elements of an enterprise can be accessed from:
• Its properties pages, see Defining Enterprise Strategic Elements,
• Its enterprise diagram, see Creating an Enterprise Diagram,
• Click the Business > Strategic Planning navigation menu.

Creating an Enterprise
 For more details Enterprises, see “Enterprises and Libraries” 
chapter in the  HOPEX Common Features guide .

Accessing the list of enterprises with HOPEX IT Business Management 
To access the list of Enterprises:

 Click the Business navigation menu then Strategic Planning.
The enterprise tree appears.

Creating an enterprise with HOPEX IT Business Management 
To create an enterprise from the Business navigation menu:

1. Click Strategic Planning.
The enterprise tree appears.

2. Click the New button.
The new enterprise is added to the list of Enterprises.
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Enterprise characteristics
The Characteristics properties page of an enterprise provides access to:

• its Name,
• its Owner, by default the current library.
• The Strategic Theme table enables to define the enterprise strategic 

themes.
 A strategic theme is used to classify the enterprise goals.

Connecting the capability map to an enterprise
The business capabilities valid for the given enterprise are contained in a business
capability map. 

 A business capability map is a set of business capabilities with their 
dependencies which define a framework for an enterprise stage.

The business capability map is used to identify the exhibited  business capabilities
that meet the enterprise goals for the transformation.

 For more details on the business capability maps management, see 
Building the Business Capability Map.

To connect a business capability map to an enterprise:
1. Select Characteristics property page of the enterprise that interests 

you.
2. In the Capability Architecture section, click the right arrow of the 

Business Capability Map field and select Connect....
A selection window opens.

3. Select the business capability that interests you and click Connect.
The business capability map is associated to the enterprise and its
transformation stages.

Connecting the value stream to an enterprise
 A value stream is an end-to-end collection of Value Stages that 
creates an outcome for a customer, who may be the ultimate customer 
or an internal end-user of the value stream.
 For more details on the list of business capabilities, see Describing 
Value Streams.

The value creation steps are connected to Business Capabilities valid for the
enterprise.

 A value stage is a distinct, identifiable phase or step within a value 
stream that has a unique entrance criteria, exit criteria, and identifiable 
participating business function or business functional area.

To connect a value stream to an enterprise:
1. Select Characteristics property page of the enterprise that interests 

you.
2. In the Value Stream section, click Connect.

A selection window opens.
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3. Select the Value streams that interests you and click Connect.
The value streams are connected to all the enterprise  transformation
stages.

Defining Enterprise Strategic Elements
Strategic elements of an enterprise are classified in the following categories:

• Ends, see: Identifying enterprise ends,
• Means, see: Defining Means.
• The transformation stages, see Defining Transformation Stages.

Identifying enterprise ends

Describing the Enterprise Vision
 A vision is the ultimate, possibly unattainable, state the enterprise 
would like to achieve. A vision is often compound, rather than focused 
toward one particular aspect of the business problem. A vision is 
supported or made operative by missions. It is amplified by goals.

To describe an enterprise vision:
1. Open the Strategy properties page of an enterprise.
2. In the End section, select the Vision field.

Identifying enterprise goals

The enterprise goals are determining elements in your enterprise model since they
interconnect the ends of the enterprise transformation with the objectives of the
transformation stages. 

 A goal tends to be longer term, and defined qualitatively rather 
than quantitatively. It should be narrow-focused enough that goals can 
be defined for it.

To create an enterprise goal:
1. In the  Strategy property page of an enterprise, open End section.
2. In the Goals section, click New.

The Creation of an Enterprise Goal dialog box opens.
3. Specify the goal name and click OK.

The goal appears in the list.

The Characteristics page of the property pages of an enterprise goal is used to
access:

• its Name,
• its Owner, by default the current enterprise.
• the Comment text. 
• the Strategic Theme Category section, which specifies the Strategic 

Themes connected to the enterprise goal.
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Defining Means
To ensure that the strategies and tactics implemented in the enterprise correspond
to the enterprise goals, you can use HOPEX IT Business Management  to align
the objects representing the ends of the strategy with the means to be
implemented.

 A strategy is a component of a mission. It represents a means of 
action essential to achievement of ends of the enterprise, and more 
practically its goals. A strategy channels enterprise efforts towards 
these goals. A strategy is the approach considered by the enterprise as 
being the best suited to achieving its goals, taking account of 
constraints imposed by the environment and by risks.

To check the consistency of the transformation plan, each strategy is connected to
an enterprise goal.

Describing a Mission
 The mission describes what the business is or will be doing on a 
day-to-day basis. A mission makes a vision operative; that is, it 
indicates the ongoing activity that makes the vision a reality. A mission 
is planned using strategies.

To describe an enterprise Mission :
1. Open the  Strategy property page of the enterprise.
2. In the Means section, select the  Mission field.

Defining Strategies
 A strategy is a component of a mission. It represents a means of 
action essential to achievement of ends of the enterprise, and more 
practically its goals. A strategy channels enterprise efforts towards 
these goals. A strategy is the approach considered by the enterprise as 
being the best suited to achieving its goals, taking account of 
constraints imposed by the environment and by risks.

To create a strategy:
1. Open the Strategy properties page of an enterprise.
2. In the Mean section and the Strategy Sub-section.
3. Click New.

The Creation of a strategy dialog box opens.
4. Specify the strategy and click the OK button.

The new strategy appears in the list.

The Characteristics properties page of the strategy provides access to:
• its Name,
• Its Enterprise,
• the Comment text. 
• the list of Supported Goals.



64

Building an Enterprise Diagram
An enterprise diagram is used to describe the links between goals, strategies, tactics
and transformation stages.

Creating an Enterprise Diagram
To create an Enterprise Diagram:

1. Select the enterprise concerned and click New > Diagram.
2. Select Enterprise Diagram.

The diagram opens in the edit area. The frame of the described  enterprise
appears in the diagram.

Describing the strategic elements
The components represented in an enterprise diagram are the strategic elements
connected to the enterprise and to its Transformation stages.

 A Business Transformation Stage is a kind of Enterprise 
Transformation Stage aiming at the alignment of the enterprise 
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business operating model to its business strategy and corresponding 
exhibited business capabilities (business model).
 For further details, see The strategic elements of a transformation 
phase.

The components represented in an enterprise diagram are :
• The enterprise ends, described by the enterprise goals and the 

enterprise objectives (that are described at the transformation stages)).
 A goal tends to be longer term, and defined qualitatively rather 
than quantitatively. It should be narrow-focused enough that goals can 
be defined for it.

 An Enterprise Objective is a quantifiable end that a company/
organization wants to achieve for a given Enterprise Stage. An 
Enterprise Objective may support an Enterprise Goal; it may be refined 
into sub-objectives. An Enterprise Objective may concern a defined 
Exhibited Capability and be addressed by a defined Tactic.

• The enterprise means that are described by strategies at the enterprise 
level and by tactics at the transformation stage level.

 A strategy is a component of a mission. It represents a means of 
action essential to achievement of ends of the enterprise, and more 
practically its goals. A strategy channels enterprise efforts towards 
these goals. A strategy is the approach considered by the enterprise as 
being the best suited to achieving its goals, taking account of 
constraints imposed by the environment and by risks.

 A tactic is a course of action that implements part of a strategy. 
Tactics generally channel efforts towards objectives.
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THE STRATEGIC ELEMENTS OF A TRANSFORMATION PHASE

The implementation of an enterprise is described by the enterprise stages that
correspond to its state at a given time.

 An Enterprise is a purposeful undertaking, conducted by one or 
more organizations, aiming at delivering goods and services, in 
accordance with the enterprise mission in its changing environment. 
During its development over time, an enterprise has to adapt to its 
environment and sets up transformation goals and objectives along with 
course of action to achieve these objectives. The design and realization 
of the resulting transformation stages may transcend organizational 
boundaries and consequently require an integrated team working under 
the direction of a governing body to involve stakeholders in 
transformation initiatives. This requires the implementation of an 
integrated team, under the responsibility of a governing body, to 
involve the stakeholders in the transformation.

 A Business Transformation Stage is a kind of Enterprise 
Transformation Stage aiming at the alignment of the enterprise 
business operating model to its business strategy and corresponding 
exhibited business capabilities (business model).

Thus, when an enterprise is created, the following two enterprise stages can also
been created:

• The current ('As-Is') stage that concerns existing elements;
• The target 'To-Be' phase that contains the target elements determined 

by the review of the transformation strategic goals.

The business capability map is associated to the enterprise and its transformation
stages. 

 A business capability map is a set of business capabilities with their 
dependencies which define a framework for an enterprise stage.

The strategic elements of a transformation phase Users that follow:
• The enterprise objectives and the corresponding tactics, see 

Transformation stage characteristics,
• the business Capability assessments, see Using performance indicators,
• the exhibited business capabilities, see: Managing Exhibited Business 

Capabilities.

Defining Transformation Stages
From an enterprise, you can create transformation stages.

Each transformation stage is scheduled in the enterprise project depending on real
or estimated dates. The scheduling is used to build the enterprise transformation
roadmap.
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Creating a Transformation Stage 
To create a transformation stage from an enterprise:

1. Click the Business > Strategic Planning navigation menu. 
The list of current Enterprises appears.

2. Open the  Strategy properties page of the enterprise that interests you.
3. In the Stages section, click New.

An IT transformation stage creation dialog box opens.
4. Specify the Name of the transformation stage.
5. Specify the Period of the transformation stage: As Is, Future or Passed.
6. Specify the Begin Date and the End Date.
7. Click OK.

 Transformation stage properties
With HOPEX IT Business Management , a transformation stage is described by:

• the Characteristics page,
 For more details on transformation stages, see Transformation 
stage characteristics.

• the Assessment property page that provides access to the assessment 
business capabilities of an enterprise stage.

 For more details on assessing capability maps, see Using 
performance indicators.

• the exhibited capabilities page that is used to access to  the business 
capabilities involved in the transformation stage.

 For more details on strategic elements, see Managing Exhibited 
Business Capabilities.

• The Architecture Description page that is used to access to  the 
architecture elements involved in the transformation stage.

 For more details on architecture elements, see Describing an 
Enterprise Architecture.

 Transformation stage characteristics

The Characteristics property page of an enterprise stage provides access to the
following information:

• Name,
• Owner the current enterprise,
• Period, As Is, Future or Passed. This attribute can be used if the dates 

are not specified.
• Begin Date of the phase,
• End Date of the phase,
• the Description text.
• the objectives section, to define the transformation stage objectives as 

well as associated tactics.
 For more details on objectives and tactics, see Defining the 
Strategic Characteristics of a Transformation Stage.
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 Defining the Strategic Characteristics of a Transformation Stage
The enterprise strategic elements are aligned with strategic element of the
transformation stage: enterprise goals and objectives, strategies and tactics.

 For more details on enterprise strategic elements, see Defining 
Enterprise Strategic Elements.

Defining an enterprise objective
 An Enterprise Objective is a quantifiable end that a company/
organization wants to achieve for a given Enterprise Stage. An 
Enterprise Objective may support an Enterprise Goal; it may be refined 
into sub-objectives. An Enterprise Objective may concern a defined 
Exhibited Capability and be addressed by a defined Tactic.

Creating an Enterprise Objective

To create an Enterprise Objective:
1. Open the Characteristics properties page of a transformation stage.
2. In the Objectives section, click New.

The Creation of an enterprise objective dialog box opens.
3. Specify the objective name and click OK.

The new enterprise objective appears in the list.
4. In the Enterprise goals column of the table of enterprise objectives, 

select the enterprise goals covered by the objective.
 A goal tends to be longer term, and defined qualitatively rather 
than quantitatively. It should be narrow-focused enough that goals can 
be defined for it.
 For more details on enterprise goals, see Identifying enterprise 
ends

Enterprise Objective properties

The Characteristics  property page of an enterprise objective is used to access:
• its Name,
• its Owner, by default the current transformation stage.
• the Comment text. 
• the list of Enterprise goals the objective aims to satisfy.

Defining Tactics
 A tactic is a course of action that implements part of a strategy. 
Tactics generally channel efforts towards objectives.

Creating tactics

A tactic is a way to achieve an enterprise objective. So a tactic is created from an
enterprise objective. 

To create a tactic:
1. Open the Characteristics properties page of a transformation stage.
2. In the Objectives section, select the objective that interests you.
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3. In the Contributing Tactic section, click New.
The new tactic appears in the list.

4. Specify the name of the tactic.
5. In the Strategy column of the tactic table of the transformation stage, 

select the strategy corresponding to the tactic.

Tactic properties

The Characteristics property page of the tactic provides access to:
• its Owner, by default the current enterprise.
• its Name,
• the Comment text. 
• the list of Supported enterprise objectives.

 For further details, see Creating an Enterprise Objective.

• the list of Strategies that it implements.
 For further details, see Defining Strategies.
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USING PERFORMANCE INDICATORS

Qualifying Values and Measurable Properties are used to define the performance
constraints that must be complied with by the building blocks making up the
enterprise, at the forefront of which are the business capabilities and the exhibited
business capabilities in a transformation stage.

The nature of a Qualifying Value is defined by a Measurable Property. 
 A measurable property expresses the nature of indicators 
(duration, mass, cost, etc.) and defines the unit used to measure them 
(minutes, kilograms, euros, etc.). Measurable properties are used to 
define indicators, they can be elementary or composite. Elementary 
measurable properties are described by measurement units: kg, Liter, 
Gallon, Hour, Minute.

 A Qualifying value (key indicator) defines how much of something 
can be quantified, either as a singular value or as range of values, 
according to a Measurable Property. Key indicators are valued. 
Example: Response Time < 20 seconds.

Measurable Properties can be connected to the some objects such as:
• business capabilities,
• value streams,
• Business Skill, 
• application environment

A Measurable Property for the "Command management" business 
capability is "Delivery time".

Qualifying Values can be connected to exhibited business capabilities; that is, a
capability highlighted within the context of a transformation stage. A Qualifying
Value is attached to a Measurable Property.

For example, the Qualifying Values of the "Command 
management" exhibition of the exhibited business 
capability) in a given transformation stage (existing or 
future) can be "Deliver a pizza in less than 20mn" or "Take 
the order in less than 3mn".

Finally, Qualifying Values or Measurable Properties can be grouped to define Sets of
Constraint Values and Sets of Constraining Properties.

 A set of constraint values defines the grouping of elementary 
Qualifying values that should be examined together in order to 
appreciate the actual performance of a KPIed item. E.g.: a delivery 
must take place in less than 20 minutes and cost less than 5 euros.

A Set of Constraint Values is defined by different component types:
• A set of constraint values,
• A Qualifying Value,
• A Flow Measure or a Technical Flow Measure, 
• application environment.

 For more details on Flow Measure Types, see Defining 
Categorization Schemas.
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A Set of Constraining Properties is defined by different component types:
 A set of constraining properties defines the grouping of elementary 
Measurable properties that should be examined together in order to 
appreciate the actual performance of a KPIed item. E.g: a delivery must 
take place within a target timeframe AND at target cost

• Sets of Constraining Properties,
• Measurable Properties, 
• Flow Measure types, which are defined by a set of Flow measures.
• Technical flow measure types, which are defined by a set of Technical 

flow measures.
 For more details on Flow Measure Types, see Defining 
Categorization Schemas.

Describing a Measurable Property

 A measurable property expresses the nature of indicators 
(duration, mass, cost, etc.) and defines the unit used to measure them 
(minutes, kilograms, euros, etc.). Measurable properties are used to 
define indicators, they can be elementary or composite. Elementary 
measurable properties are described by measurement units: kg, Liter, 
Gallon, Hour, Minute.

Accessing the list of  Measurable Properties of a Library
To access the list of Measurable Properties:

1. Expand the Environment > Containers navigation menu.
2. Select the library that interests you and expand its folder.

The list of measurable properties appears in the Measures & Categories
> Measurable Properties folder.

Creating a measurable property from a business capability
To create a Measurable Property from a business capability, for example:

1. Open the Measurable Property page of the business capability that 
interests you.

2. In the Measurable Property section, click New.
A Measurable Property creation dialog box opens.

3. Specify:
• its Name,
• the text that describes its Unit,
• the text of its Description.
4. Click OK.

The new Measurable Property appears in the section. It’s connected to the
current library.
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The properties of a Measurable Property
The Characteristics property page of a Measurable Property provides access to:

• its Name,
• the text that describes its Unit,
• the text of its Description.

The Usage property page of a Measurable Property provides access to:
• the Qualifying Value section provides the list of Qualifying Values that 

are based on this Measurable Property.
 For further details, see Connecting a Measurable Property to a 
Qualifying Value.

• the Set of Constraining Properties section which provides the list of 
sets of constraining properties associated to the Measurable Property.

 For further details, see Creating a Set of Constraining Properties 
from an object of an enterprise.

Describing a Qualifying Value

 A Qualifying value (key indicator) defines how much of something 
can be quantified, either as a singular value or as range of values, 
according to a Measurable Property. Key indicators are valued. 
Example: Response Time < 20 seconds.

Accessing the list of Qualifying Values
To access the list of Qualifying Values of a library:

1. Expand the Environment > Containers navigation menu.
2. Select the library that interests you and expand its folder.

The list of Qualifying Values appears in the Measures & Categories >
Qualifying Value folder.

Creating a Qualifying Value from an exhibited business capability
A Qualifying Value can be used by an exhibited business capability. It appears in the
Qualifying Value property page of the exhibited business capability.

 An exhibited business capability is exhibited by an Enterprise Stage 
with quantified measure (KPI) and potential geopolitical scope (Site) for 
a defined market segment (Business Partner).
 For more details on exhibited business capabilities, see Managing 
Exhibited Business Capabilities.
 You create a Qualifying Value from the Qualifying Value property 
page of all the objects that can be connected to simple or composite 
performance indicators

To create a Qualifying Value from an exhibited business capability:
1. Open the Qualifying Value page of the exhibited business capability 

that interests you.
2. In the Qualifying Value section, click New.

The Qualifying Value creation dialog box opens.
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3. Select the Measurable Property that you would like to use.
For example, "Delivery time"

4. Select the operator that you want to use (less than, greater than or 
equal to).

For example, "Less than"
5. Specify the Value.

For example “48 hours”
6. Click OK.

The Qualifying Value is created with a Name calculated from its
characteristics.

In the example, the name is "Delivery time < 48 hours"

The properties of a Qualifying Value
The Characteristics property page of a Measurable Property provides access to:

• its Name, which is calculated automatically on creation,
• Its Measurable Property which defines its nature,
• its Unit, which is that of the Measurable Property and which cannot be 

modified,
• its Operator which positions it with respect to its value,
• its Value,
• the text of its Description.

The Usage property page of a Qualifying Value provides access to:
• the Set of Constraint Values section: provides the list of Qualifying 

Values that use the Qualifying Value described.
 For further details, see Creating a Set of Constraint Values from an 
exhibited business capability.

• the Exhibited Capabilities section: provides the list of exhibited 
capabilities connected to the Qualifying Value.

 For further details, see Creating a Qualifying Value from an 
exhibited business capability.

Connecting a Measurable Property to a Qualifying Value
The Measurable Property is mandatory for the creation of a Qualifying Value; it is
used in calculating the name of value: Measurable Property name + logical
operator + Measurable Property unit.
The Measurable Property is given in the Qualifying Value property page.

To connect a Measurable Property to a Qualifying Value:
1. Open the Characteristics property page of the Qualifying Value that 

interests you.
2. In the Measurable Property field, select the Measurable Property you 

are interested in.
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Creating a Set of Constraining Properties from an object of an enterprise
 A set of constraining properties defines the grouping of elementary 
Measurable properties that should be examined together in order to 
appreciate the actual performance of a KPIed item. E.g: a delivery must 
take place within a target timeframe AND at target cost

A Set of Constraining Properties uses either a Measurable Property, or a Set of
Constraining Properties.

A Measurable Property or a Set of Constraining Properties can be used by several
Sets of Constraining Properties. During creation of a Set of Constraining Properties,
you can thus reuse a Measurable Property or a Set of Constraining Properties that
already exists.

To create, for example, a Set of Constraining Properties from a business capability:
1. Open the Measurable Property page of the business capability that 

interests you.
2. In the Set of Constraining Properties section, click New.

A Set of Constraining Properties creation window opens.
3. Enter the Name.
4. In the Owned property Component section, click New.

An Add window appears:
5. Select the Object Type: Set of Constraining Properties or 

Measurable Property.
6. Select the object that interests you and click Next.

The new component appears in the list.
7. Click Add and proceed the same way to connect other Measurable 

Properties or Set of Constraining Properties.

Creating a Set of Constraint Values from an exhibited business capability
 A set of constraint values defines the grouping of elementary 
Qualifying values that should be examined together in order to 
appreciate the actual performance of a KPIed item. E.g.: a delivery 
must take place in less than 20 minutes and cost less than 5 euros.

A Set of Constraint Values uses either a Qualifying Value, or a Set of Constraint
Values.

A Qualifying Value or a Set of Constraint Values can be used by several Qualifying
Values. During creation of a Set of Constraint Values, you can thus reuse a
Qualifying Value, or a Set of Constraint Values that already exists.

A Set of Constraint Values can be used by an exhibited business capability. It
appears in the Qualifying Value property page of the exhibited business capability.

 An exhibited business capability is exhibited by an Enterprise Stage 
with quantified measure (KPI) and potential geopolitical scope (Site) for 
a defined market segment (Business Partner).
 For more details on exhibited business capabilities, see Managing 
Exhibited Business Capabilities.
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To create a Set of Constraint Values from an exhibited business capability:
1. Open the Qualifying Value page of the exhibited business capability 

that interests you.
2. In the Set of Constraint Values section, click New.

A Set of Constraint Values creation window opens.
3. Select a Set of Constraining Properties.
4. In the Set of Values Component section, click New.

An adding sub-indicator window opens.
5. Select the Object Type: Set of Constraint Values or Qualifying 

Value.
6. Select the object that interests you and click Next.

The new component appears in the list.
7. Click New and proceed the same way to connect other key indicators
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BUSINESS CAPABILITY MAPS AND VALUE 
STREAMS

To manage your business transformation initiatives, HOPEX IT Business Management  offers a
methodological framework established from international standards (BIZBOK and other
architectural frameworks of NAF/DoDAF and TOGAF type), as well as our experience in this area. 

The first step of this method consists in analyzing the value streams of your enterprise and
connecting them to business capabilities you have identified. 

Then you can check the suitability of your business capabilities with your business functions and
your skills. This work leads to a better understanding of the current state of your organization ('As-
Is').

The following points are covered in this chapter:

 Describing a Business Capability Map
 Describing Value Streams
 Describing Functional Coverage
 Describing Component Fulfillment
 Describing the data of a Business Capability
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DESCRIBING A BUSINESS CAPABILITY MAP

A business capability defines an expected skill. 
 A business capability represents a specific ability that an 
organization possesses or needs to develop to deliver a particular 
business outcome.

For example, to meet a customer satisfaction objective, the 
organization must be able to provide services conforming to 
contractual commitments.

A capability map describes what the enterprise is capable of producing for its
internal needs or to meet the needs of its clients. It is based on the main business
capabilities of its activity at a given moment. 

 A business capability map is a set of business capabilities with their 
dependencies which define a framework for an enterprise stage.

Building the Business Capability Map
A business capability map is used to represent the main business capabilities that
interact with an enterprise.

Creating a business capability map
To create a business capability map:

1. In the Business navigation menu, click Capabilities.
The business capability map tree appears.

2. Click New.
3. Specify the Name and click OK.
4. Specify an Owner (library, enterprise, etc.).

The new business capability map appears in the list.
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Creating a business capability decomposition tree
A Business Capability Decomposition Tree is a diagram that describes the tree
structure of a business capability or a business capability map. Focusing on a
particular business capability, this type of diagram enables summary representation
of business capability breakdown into sub-business capabilities.

To create a business capability map diagram:
1. Click the business capability map to open its properties.
2. From the Diagrams page, click Create a diagram.
3. Hover the mouse over Capability decomposition and click Create this 

diagram.
The frame of the business capability map described appears in the
diagram.
You can build a hierarchical view of the business capabilities that interest
you.

Creating a capability structure diagram
A capability structure diagram is a capability map diagram which represents:

• the main business capabilities interacting within the enterprise
• dependency links between business capabilities.

For example, the business capability that consists of 
managing operations is broken down into a number of business 
capabilities such as: “Handle customer complaints”, “Manage 
travel reservations”. 

To create a capability structure diagram:
1. Click the business capability map to open its properties.
2. In the Diagrams page, click Create a diagram.
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3. Hover the mouse over Capability structure and click Create this 
diagram.
The frame of the business capability map described appears in the
diagram.
You can construct this diagram in tabular entry mode.



 For more information on using tabular entry, see the “Diagrams in 
Tabular Entry Mode" in the HOPEX Common Features guide.

 Defining capabilities in a capability diagram
To add a business capability to a business capability map diagram:

1. In the diagram Insert toolbar, click Capability.
2. Click in the frame of the business capability map.
3. In th add dialog box, select or search for a capability and click Create.

The capability appears in the diagram.
 If the business capability is associated with functionalities, they 
also appear. For more details on the capabilities and functionalities 
associated with business capabilities, see Defining business skills and 
functionalities associated with capabilities.

Defining business capability dependencies
A dependency link between a capability and another is used to specify the elements
on which this dependency is based. 

 A single capability can have more than one dependency within a 
single diagram.

To create dependency links between two business capabilities:
1. In the Insert toolbar, click Business Capability Dependency.
2. Click the user capability, and keeping the left mouse button pressed, 

move the cursor to the capability used.
3. Release the mouse button.

The business capability appears in the diagram.

Describing a Business Capability

Creating a business capability from a business capability map diagram
You can create a business capability from a business capability map diagram:

1. In the Business navigation menu, click Capabilities.
The business capability map list appears.

2. Move the mouse over the relevant business capability map and click the 
New > Business Capability button.

3. Name the business capability and click OK. 
The new business capability appears under the map.
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Defining the properties of a business capability
To display properties of a business capability:

 In the navigation tree, select the business capability of interest.

The Characteristics property page of the business capability map provides access
to:

• its Owner. By default, when a business capability is created, it is the 
current enterprise.

• the text of its Description
• its Sub-capabilities
• its Supporting Assets 

Other pages can be used to complete the description of a business capability. The
Dependencies page lists dependent business capabilities and required business
capabilities.

 Note that some of the pages can be hidden by default.

Defining business skills and functionalities associated with capabilities
Each business capability is associated with business skills and functionalities.

To associate a skill with a business capability:
1. Open the Expected Capabilities properties window of the business 

capability.
 This page is not necessarily displayed by default.

2. In the Expected Business Skill section, click New.
3. In the add dialog box, select or search for a business skill and click 

Create.
The business skill appears in the list of skills associated with the business
capability.

 For more information on enterprise skills, see Describing Business 
Functions. 

To associate a functionality with a business capability:
1. Open the property pages of the business capability concerned and select 

the Expected Capabilities page.
2. In the Expected Functionality section, click New.
3. Select a functionality and click Add.

The functionality appears in the list of functionalities associated with the
business capability.

 For more information on enterprise functionalities, see Describing 
functionalities. 
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In diagrams, business skills and functionalities appear at the bottom of the frame of
the capability described.

A report is available to check the suitability between the business capability map and
the operational environment. For more details, see Describing Component
Fulfillment.

Business Capabilities Reports
Dynamic reports enable you to analyze the business capabilities of your repository
according to different perspectives.

 For detailed information on reports, see Generating Reports.

Business Capability Map Breakdown Report
You can use a breakdown report to visualize the objects that make up a business
capability map and the realization of capabilities by EA equipment.

This report is available in the Business Capabilities Properties Reports page.

Example
The example below shows the coverage of the business 
capability map by applications, with the “Technical 
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efficiency” and “Business value” criteria available on the 
applications.



 For more details on use of a breakdown report, see the, chapter 
"Handling a Breakdown Report" in the HOPEX Common Features 
guide.

Business Capability Coverage over Time
This report provides a temporal representation of the elements that make up a
business capability map and the applications or application systems that cover
them.

Applications are analyzed according to various possible criteria. A timeline shows
their evolution over several years. 

The criteria selected applies to both views of the report:
• Capabilities Time analysis:  a treemap displays the various business 

capabilities and the applications that cover them. 
• Criteria Time Analysis: a table displays the values of the selected 

indicators according to the dates indicated.

Example

Below is the coverage report for the “MEGA Bank” capability map.

The report displays the list of associated applications and the criteria selected
(Current state, Technology compliance, Functional support, Business value).



84

A point on the timeline indicates the date of the values displayed in the report. You
can move this point to view the evolution of indicator values over time.

A Legend button shows the meaning of the indicators and their colors.

Launch the report

To generate a Business Capability Coverage over Time report:
1. Click the Reports menu.
2. To the right of the edit area, click the Create a report button.
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3. Find the “Business Capability Coverage over Time” report template.
4. Select the report type and click Create a report.

The report creation wizard opens.
5. Select:

• the business capability map
• the analysis criteria
• if required, the portfolio of applications to be evaluated.

6. Click Preview then Continue.
7. Give the report a name and a description. 
8. Click Save and open.

Business Capabilities Tree Map
This report breaks down a capability tree in the form of a treemap according to one
of three possible criteria:

• Number of components: the surface area is proportional to the number 
of sub-capabilities in the tree.

• Application ratio: the surface area is proportional to the realization 
percentage of the current capability by applications.

• Cost of applications: the surface area is proportional to the cost of 
applications realizing current and descendant capabilities in the tree.

Take note that:
• Since an application can realize several capabilities, the "Cost 

Contribution Key" ratio is applied to the criteria "Application ratio" and 
"Cost of Applications".

• An application realizing an "intermediate" capability (i.e. not a leaf of the 
tree) is considered to realize all its sub-capabilities in a uniform way 
(strict pro rata between all sub-capabilities).

To generate the business capability map breakdown from an application portfolio:
1. Open the properties of the portfolio in question.
2. Click Reporting > Business Capability Tree Map. 
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3. Select a capability map.
4. Refresh the report.



 For more details on use of a Treemap, see the chapter “Handling a 
Treemap" in the HOPEX Common Features guide.
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DESCRIBING VALUE STREAMS

 A value stream is an end-to-end collection of Value Stages that 
creates an outcome for a customer, who may be the ultimate customer 
or an internal end-user of the value stream.
 To display the Value streams, open the Options window and 
check that HOPEX Solutions > Business Process Analysis > Value 
Stream Modeling is activated.

Value Stream Example
In this value stream diagram, the Business Function or the Business Functional Area
that create the value streams are linked to the participants represented in columns.

The following diagram presents an example of a value stream: 

"Purchase reception" value stream

The purchase request is recorded and must then be approved. 
The requester is informed of the approval or rejection of 
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the request. If the request is validated, an analysis of the 
required order is carried out. 
If stock is lower than a given threshold, an order is 
prepared and sent to the supplier for resupply.
If the product is available, or as soon as it is received 
from the supplier, it is made available to the requester.

In this example, the business functions concerned are represented in columns.
 A business function is a conceptual unit of the division of 
responsibilities in an enterprise. It is used to structure the management 
of information processing, energy, and equipment produced or used. 
Business functions define the skills and the functionalities necessary to 
the enterprise to fulfill its mission.

In the organization previously presented, three org-units: purchasing assistant,
purchasing manager and buyer, systematically participate to execute the first four
steps: record and approve the request, analyze and send the order.

Optimization of the organized process "Process Purchase Requests" has saved one
step: when the amount of the order is not significant, the purchasing assistant can
himself approve or refuse the purchase request.

In case of urgent orders, you can again save steps by authorizing the purchasing
assistant to send the order when the amount is not significant.
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We obtain the following value stream for processing of urgent orders:

"Purchase reception" value stream

The first step consists in analyzing the purchase request. 
If the total amount is large, normal processing is carried 
out.
Otherwise, the availability request and a restock request 
are sent, if necessary. Continuation of this value stream is 
identical to the previous one: when the order has been 
received, it is made available to the requester.

Value Stream representation principles

Highlighting organizational choices

Each enterprise has activities related to its business that must be performed
whatever the organization in place. These activities can be purchasing, sales, sales
administration, manufacturing, etc.

Defining their organization consists in assigning these activities to the org-units that
will perform them.

We can distinguish between:
• Processes relating to the business of the enterprise: these are difficult to 

change unless the enterprise decides to totally review its business.
• Processing depending on organizational choices.
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Number of steps

Certain steps in a process are exclusively linked to the chosen organization. In such
cases, it is useful to check whether these steps provide any real added value to
clients or only concern the way things are done.

Delivery times can also be reduced by restructuring the order of these steps.

To highlight possible improvements, you can represent a value streams by flows
exchanged between enterprise value stage.

 A value stage is a distinct, identifiable phase or step within a value 
stream that has a unique entrance criteria, exit criteria, and identifiable 
participating business function or business functional area.

Using Value Streams 

 A value stream is an end-to-end collection of Value Stages that 
creates an outcome for a customer, who may be the ultimate customer 
or an internal end-user of the value stream.

Accessing value streams
To access the list of Value Streams: 

 From the Business navigation menu, click Business Values.
The list of value streams appears.

Creating a value stream
To create a Value stream: 

1. See Accessing value streams.
2. Click New > Value streams.

Creating a value stream diagram
To create a value stream diagram:

1. Select the value stream of interest and click Create Diagram.
A window opens and prompts you to choose the Diagram Type that you
wish to use:

2. Select the diagram type you want to create.
• a value stream diagram, see The value stream diagram;
• a value stream to capability diagram, see The value stream to capability 

diagram;

The value stream diagram
 This diagram is used to describe a value stream with the BPMN 
notation. It presents the sequence of the value creation steps 
performed, the events that occur and the conditions under which they 
are sequenced. It also makes it possible to assign the participants who 
carry out these value-creation steps to the business skills needed to 
implement them. This representation of a value stream helps to answer 
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the following question: "What are the skills needed to implement the 
value stream?".
 This type of diagram makes it possible to describe precisely the 
enterprise value streams.

The value stream to capability diagram

The value stream to capability diagram can only be used in tabular input mode.


 For more information on using tabular entry, see the “Diagrams in 
Tabular Entry Mode" in the HOPEX Common Features guide.

This diagram makes it easy to initiate a value stream diagram by creating the value
stream steps and the links they have with the different business capabilities.

 For more information on business capabilities, see Business 
Capability Maps.

Representing the Value Stream Implementation
You can represent the fulfillment of a value stream by a process.

To access the list of Processes from the Environment navigation menu: 
1. Click the Organization > Processes menu.
2. Open the Characteristics property page of the process that interests 

you.
3. In the Fulfillments section, click the New button.
4. In the Add dialog box, select Value Stream Fulfillments and select the 

concerned value stream.
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Describing the Functionality Map

 A technology capability map is a set of technology capabilities and 
their dependencies that, together, defines the scope of a hardware or 
software architecture.

Accessing the list of functionality maps
To access the list of Functionality maps:

 In the Inventories navigation menu, click Capabilities > 
Functionalities.
The tree of functionality maps appears.

Properties of a functionality map
The Characteristics properties page of a functionality map provides access to:

• its Owner.
• its Name
• the text of its Description
• the Owned Functionalities section

 For more information on the functionality components, see:
• Creating a functionality component in a functionality map diagram 
• Defining Functionality dependencies.

With HOPEX IT Business Management , a functionality map is described in the
Reporting property page.

Creating a functionality map diagram
To create a functionality map diagram:

1. Right-click the functionality map of interest and select New > Diagram.
2. Select Functionality Structure and click Create this diagram.

The diagram opens in the edit area. The frame of the functionality map
described appears in the diagram.

Creating a functionality component in a functionality map diagram
The components represented in a functionality map are Functionality
components.

To add a functionality component in the functionality map diagram:
1. In the diagram Insert toolbar, click Sub-functionality.
2. Click the functionality map frame.

An add functionality dialog box appears.
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3. Search for an existing functionality and click Create.
The sub-functionality appears in the diagram.

Defining Functionality dependencies
A dependency link between one functionality and another is used to specify the
elements on which this dependency is based. 

To create dependency links between two functionalities in a functionality map
diagram:

1. In the insert toolbar, click Functionality Dependency.
2. Click the functionality component, and keeping the left mouse button 

pressed, move the cursor to the functionality component used.
3. Release the mouse button.

The link appears in the diagram.
 A single sub-functionality can have more than one dependency 
within a single diagram.

Describing functionalities
To access the list of functionalities:

 In the Inventories navigation menu, click Capabilities > 
Functionalities.
The list of functionalities appears in the edit area.

To create a functionality:
1. Hover the mouse over the desired functionality map and click New > 

Functionality.
2. Specify the name and click OK.

The Characteristics property page of the functionality provides access to:
• its Owner, by default during creation of the functionality, the current 

enterprise.
• its Name
• the text of its Description
• Owned functionalities (through the section of the same name)

 Dependencies between owned functionalities are displayed in the 
Dependencies page (in which it is possible to view dependent and 
required capabilities).
 For more details on dependencies devices, see Creating a 
Functionality Diagram.
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The Capability Usage section provides access to the following information:
• the Business Capability section provides access to the business 

capabilities that require the described functionality.
 For more details on the functionalities associated with business 
capabilities, see Defining business skills and functionalities associated 
with capabilities.

• the Business Function section provides access to the business 
functions that require the described functionality.

 For more details on businesses, see Business properties.

• the Capability Exhibition section provides access to the exposed 
business capabilities that require the described functionality.

 An exhibited business capability is exhibited by an Enterprise Stage 
with quantified measure (KPI) and potential geopolitical scope (Site) for 
a defined market segment (Business Partner).

Creating a Functionality Diagram
To create a functionality diagram:

1. Hover the mouse over the functionality of your choice and click Create a 
diagram.

2. Select Functionality Structure then Create this diagram.
The diagram opens in the edit area. The frame of the functionality
described appears in the diagram.

To create a functionality from a functionality diagram, see Creating a functionality
component in a functionality map diagram.

To define the dependencies of sub-functionalities, see Defining Functionality
dependencies.

Describing the Technology Capability Map

 A technology capability map is a set of technology capabilities and 
their dependencies that, together, defines the scope of a hardware or 
software architecture.

Accessing the list of technology capability maps
To access the list of technology capability maps:

 In the Inventories navigation menu, click Technology Capabilities.
The technology capability map tree appears.

Using the technology capabilities
The use of technology capabilities is identical to the use of functionalities.

For more details, see Describing the Functionality Map.
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DESCRIBING COMPONENT FULFILLMENT

To represent the implementation of a component such as a business capability or
functionality you must create a Fulfillment of the component.

Creating Fulfillment of a Business Capability
A  business capability can be realized different object types:

• a business function
• business functional area
• a process
• an application

To associate a process to a business capability, you must create a business
capability fulfillment.

To specify that a business capability is fulfilled by a process:
1. In the Characteristics business capability property page, expand the 

Supporting Assets section. 
2. Click New.
3. In the drop-down list of the Add dialog box, select the Process object 

type. 
4. Select the desired process and click OK.

The business capability realization appears in the list with the name and
the type of the selected object.

Reports can be used to visualize the coverage of business capability elements by
operational elements such as business functions, and according to different
perspectives: Organizational, Business/Data, Logical/Physical Application, etc.

 For more details on fulfillment reports for enterprise capabilities, 
see Business Capabilities Reports.
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DESCRIBING THE DATA OF A BUSINESS CAPABILITY

Combined with HOPEX Data Architecture or HOPEX Data Governance, the
HOPEX IT Business Management  solution can be used to define the data used
at the business capability level.

Creating a Concept Domain Diagram on the Business Capability
Describing the data used in a business capability involves creating a concept domain
diagram. You can create this diagram from the business capability concerned. 

The concept domain diagram presents business data, their properties and their
relationships. 

To create the concept domain diagram for a business capability:
1. Open the properties dialog box of the business capability.
2. Click the Diagrams page.
3. Click Create a diagram.
4. Select the “Concept Domain” diagram type.

The diagram is displayed in edit mode.

Diagram Data
A concept domain includes or references a set of business data.
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The data described in the diagram and defined as “components” of the concept
domain is visible in the business capability properties, in the Characteristics page,
in the Business data section. 

 The Business Data section can be hidden by default. To display it, 
click the Manage sections button and select Business data.

To connect an element of the diagram to the list of components for a concept
domain:

1. Right-click the object to open its pop-up menu.
2. Select Add to “Current concept domain (name").

For more information on creating diagram elements, see:
• "Define Business Information > Concept Domain > Building a Concept 

Diagram" in the HOPEX Data Governance documentation.
•
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DRAWING THE TRANSFORMATION ROADMAP

Drawing up the roadmap consists of identifying the enterprise transformation stages that define the 
timeframe of the transformation goals. 

 A Business Transformation Stage is a kind of Enterprise 
Transformation Stage aiming at the alignment of the enterprise 
business operating model to its business strategy and corresponding 
exhibited business capabilities (business model).

The roadmap is used to plan the business capabilities that the enterprise must acquire to reach its 
strategic objectives. The changes in these business capabilities over time takes place through 
exhibited business capabilities.

 An exhibited business capability is exhibited by an Enterprise Stage 
with quantified measure (KPI) and potential geopolitical scope (Site) for 
a defined market segment (Business Partner).

The exhibited business capabilities are connected, through the implementations, to the technical or 
business components of the enterprise. The enterprise transformation takes place through the 
architecture components transformation.

This chapter describes the procedures to be followed to:

 Identifying Exhibited Business Capabilities,
 Describing a Business Architecture Environment,
 Describing an Enterprise Architecture,
 Drawing up the Roadmap.
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Managing Exhibited Business Capabilities

 An exhibited business capability is exhibited by an Enterprise Stage 
with quantified measure (KPI) and potential geopolitical scope (Site) for 
a defined market segment (Business Partner).

Accessing the list of exhibited business capabilities
To access the list of exhibited capabilities of a transformation phase:

1. Click the Business > Strategic Planning navigation menu.
2. Select the enterprise that interests you and unfold the tree of strategic 

components.
3. Expand the Transformation stages folder.
4. Expand the tree corresponding to the strategic components of the 

transformation stage of interest.
5. Expand the Exhibited Business Capabilities folder.

The exhibited business capabilities list is displayed.

Creating an exhibited business capability
To create an exhibited business capability from a transformation stage:

1. Open the Exhibited Capabilities properties page of the transformation 
stage.
A page presents the tree of the business capabilities of the enterprise 
business capability map.

2. Select the business capabilities that interests you and click Add.
The exhibited business capability is created and appears in the Exhibited 
business capability column.

3. Select the exhibited business capability.
The Exhibited business capability property page opens on the right.

4. In the Enterprise objectives column, click the arrow to display the 
transformation stage objectives.

5. Select the objectives concerning the exhibited capability.
6. In the Business Capability Realization column, click the arrow to 

display the realizations of the current business capability in 
transformation stage context.

 For more details on implementation of business capabilities, see 
Creating Fulfillment of a Business Capability.

7. Select the realizations concerning the exhibited capability.
 The details of elements connected to an exhibited business 
capability are displayed in a transformation stage report, see Stages 
Capabilities Synthesis report.
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The properties of an exhibited business capability
The Characteristics property page of the exhibited business capability provides 
access to:

• its Name,
• its Owner, by default the current transformation stage,
• Desired Capability Effect, provides access to the exhibited business 

capability outcomes.

An exhibited business capability is described by the following pages:
• the Structure page specifies:

• the list of business capability components that constitute the exhibited 
business capability

• the dependencies between these components,
 For more details on business capabilities components, see:
• Defining capabilities in a capability diagram
• Defining business capability dependencies.

• the Fulfillments page provides access to the list of Components that 
implement the business capability.

 For more details on implementation of business capabilities, see 
Creating Fulfillment of a Business Capability.

• The Qualified Value and Measurable Property pages provide access 
to the list of indicators associated with the exhibited business capability.

 For more details, see Using performance indicators.

• the Assessment page provides access to the assessment results of the 
business capabilities realization.

 For more details on the assessments of business capabilities, see 
Creating a business capability assessment.

• the Transformation page provides access to transformation stages 
connected to the exhibited business capability.
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Stages Capabilities Synthesis report
This report is available on a dedicated Report properties page of the transformation 
stage. It presents a view of the enterprise business capabilities highlighting the 
exhibited business capabilities.

Using Assessment for Business Capabilities and their 
Implementation

The assessment are based on a business capability map and are accessible using 
the enterprise stages to which the map is connected. These assessments are 
therefore valid in the context of a transformation stage and at a given date.
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Creating a business capability assessment
The assessment of business capabilities deals with the following characteristics:

• the Business Value: characterizes the value that the business capability 
brings to the company. It can be used to position a business capability on 
a strategic scale (very strategic or very non-strategic).

• the Capability Effectiveness: characterizes the quality of what the 
business capability produces, regardless of the resources used. Allows 
you to assess the conformity of the result with expectations.

• the Capability Efficiency: characterizes the resources used to produce 
the expected result of the business capability. Shared resources can be 
more efficient than dedicated ones.

• the Financial Impact: characterizes the impact of the result generated 
by the business capacity on the company’s finances. Allows you to assess 
the impact of a non-compliant result on the company’s finances.

From a transformation stage, you can create a new assessment with a view to 
assessing some business capabilities connected to the enterprise business capability 
map.

To create a business capability assessment for a transformation phase:
1. Open the  Assessment> Capability Assessment properties page for 

the transformation stage that interests you.
 The transformation stage is connected to business capability map 
associated to the enterprise, see  Connecting the capability map to an 
enterprise.

2. Click the New Assessment button.
A selection window presents the tree of the business capabilities of the 
enterprise business capability map.

3. Select the business capability that you want to assess and click OK.
The selected capabilities appear in the edition area.
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4. Click the capabilities to enter the evaluation criteria.
• the business value,
• capability effectiveness,
• capability efficiency,
• financial impact.

5. Click OK to finish assessment.
The assessment results are displayed in the property page. 

6. Click the Validate Assessment button.
A validation window opens. 

7. Define the Evaluation date and click OK.
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Creating an assessment of business capability implementation
The assessment of business capabilities realization deals with the quality of the 
capability realization. The possible values are between very low and very high.

From a transformation stage, you can create a new assessment of business 
capability realizations.

To create an assessment of business capability implementation in a transformation 
stage:

1. Open the  Assessment > Capability Realization Assessment 
properties page for the transformation stage that interests you.

 The transformation stage is connected to the business capability 
map associated to the enterprise, see  Connecting the capability map to 
an enterprise.

2. Click the New Assessment button.
A selection window presents the tree of the business capabilities of the 
enterprise business capability map as well as those capabilities 
realizations.

3. Select the business capability realization that you want to assess and 
click OK.
The selected capability realizations appear in the property page.

4. For each realization, complete the Capability Realization Quality 
criteria.

5. Repeat the same procedure for Business Capabilities: Validating 
Assessment by entering the assessment date.
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One of the most important phases in describing a business architecture environment 
is defining and understanding of the enterprise functional architecture.

The functional architecture enables the organization to understand, independently 
of its physical structure, which capabilities and skills it includes, those it needs, and 
how these contribute to its processes.

The description of the functional architecture also enables identification of areas of 
the organization where skills and processes are duplicated and where synergies 
exist. These areas are not necessarily visible from the organizational structure.

The following points are covered here:
• Managing a Business Architecture Environment;
• Describing a Business Functional Area;
• Describing Business Functions;
• Describing Business Partners;
• Drawing up the Roadmap.

Managing a Business Architecture Environment

 A business architecture environment represents the relationships of 
a business functional area with its partners.

A business architecture environment diagram describes the service interactions 
between the main internal components of the environment described and the 
external components. It thus describes:

• the internal and external business functional areas,

 A Business functional area is a set of business functions and their 
associated value streams on the conjunction of two main criteria: their 
need in accomplishing one or more business capabilities and the 
common skills and functionalities required to accomplish these business 
capabilities.

• the business partners,

 A business partner designates a third-party who is in relation with 
the enterprise within the framework of a given business architecture 
environment. Examples: private sector client, regulatory organization, 
supplier.

In this example, the business function architecture 
environment of company is made up of the historical business 
function architecture and its interactions with external 
partners: clients and suppliers. You can see in the diagram 
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that delivery is outsourced  to a third party deliver 
partner. 

Communications between the objects are represented by service interactions that 
represent requests and service provision.

 A Service Interaction represents an interaction for service purpose 
between entities in a specific context inside or outside a company. 
These entities can be enterprise org-units, applications, activities or 
processes, as well as external org-units. The content of this interaction 
is described in a service interface.
 For more details on service interactions between components, see 
Managing Service Interactions.

Accessing the list of Business Architecture Environments
To access the list of Business Architecture environments:

1. In the Inventories navigation menu, click Business Architecture > 
Environments.
The list of Enterprises appears.

2. Expand the business enterprise folder that interests you, as well as its 
Architecture Environment folder.

3. Expand the Reference Operating Model folder.
A list of the different environments linked to the Enterprise appears.

Creating a business architecture environment
To create a business architecture environment:

1. In the Inventories navigation menu, click Business Architecture > 
Environments.
The list of Enterprises appears.

2. Expand the business enterprise folder that interests you, as well as its 
Architecture Environment folder.
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3. From the Reference Operating Model folder, click New >  Business 
Architecture Environment.

4. Enter its Name.
The new business architecture environment appears in the list.

The properties of a business architecture environment
The Characteristics properties page of the business architecture environment 
provides access to:

• its Name,
• its Owner, 
• the text of its Description.
• its Owned Realizations 

 For more details on the realization of business capabilities, see 
Creating Fulfillment of a Business Capability.

With HOPEX IT Business Management , a business architecture environment is 
described by the following property pages:

• the Structure page which provides access to the list of components of 
the business architecture environment.

 For more details on the components of the business architecture 
environment, see Creating a business architecture environment 
diagram.

• the Implementation page, which provides access to the list of resource 
architecture environments, applications, application system or logical 
application system that implement the business architecture 
environment.

Creating a business architecture environment diagram
To create a business architecture environment diagram:

1. From the list of business architecture environments, select the one you 
are interested in and click Create diagram.

2. Select Business Architecture Environment Diagram.
The diagram opens in the edit area.
You can construct this diagram in tabular input mode.

 Tabular input is available with this diagram. For more information 
on using tabular input, see the "Entering a diagram in tabular mode" in 
the HOPEX Common Features guide.

Creating an internal or external business functional architecture 
area

To define that a functional area is used in the context of a business architecture 
environment, you can:

1. Create a Business functional Area Use component that is part of the 
architecture environment described or a Partner Business functional Area 
Use type component if it is a business functional area that belongs to 
another environment.
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2. Associating the Business functional Area fulfilled to the Business 
functional Area Use created.

In our example, the history business function is an internal 
environment element.

 For more details on business partners, see Describing a Business 
Functional Area.

To create a Business Functional Area Use:
1. In the insert toolbar for the business architecture environment diagram, 

click Business Functional Area Use.
2. Click in the business architecture environment frame described.

A creation dialog box prompts you to Connect Business Functional 
Area.

3. Select the business functional area that interests you and/or create a 
new one.

Create, for example, the “Manufacturing" business 
functional area.

4. Click OK. 
The business functional area appears in the diagram.

 Proceed in the same way to create an External Partner Business 
Functional Area Use:

Creating a business partner component

To describe a business architecture environment that uses participants internal or 
external to the environment described, you must:

1. Create a Business Partner Component.
2. Associate the person (or the person group) to the Business Partner 

Component created.
In the example of the business architecture environment of 
the manufacturing company, the business partners used are 
the clients and the service provider who ensures the 
delivery. 

 For more details on business partners, see  Describing Business 
Partners.

To create a Business Partner Component:
1. In the insert toolbar for the business architecture environment diagram, 

click Business Partner Component and click in the frame of the 
diagram.
A creation window prompts you to choose the existing Business Partner
or create a new one.

Create for example the "Clients" business partner.
2. Click OK. 

The business partner use appears in the diagram.

Describing a Business Functional Area

 A Business functional area is a set of business functions and their 
associated value streams on the conjunction of two main criteria: their 
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need in accomplishing one or more business capabilities and the 
common skills and functionalities required to accomplish these business 
capabilities.

Accessing the business functional area list
To access the business functional area list:

1. In the Inventories navigation menu, click Business Architecture > 
Business Functions.
The tree of business functional areas appears.

The properties of a business functional area
The Characteristics properties page of a functional area provides access to:

• its Name,
• its Owner, by default on creation of the business functional area, the 

current enterprise.
• the text of its Description.
• its Owned Realizations 

 For more details on creating a business capability, see Creating 
Fulfillment of a Business Capability.

With HOPEX IT Business Management , a business functional area is described 
in the following pages:

• the Structure page, which provides access to the list of components of 
the business functional area.

 For more information on the components of a business functional 
area, see Describing a business functional area diagram.

• the Performed Process page, which provides access to the value 
streams executed in the context of the business functional area.

Describing a business functional area diagram
A business functional area diagram describes the service interactions between the 
main internal components of the architecture described. It thus describes:

• the uses of the business functional area,

 A Business functional area is a set of business functions and their 
associated value streams on the conjunction of two main criteria: their 
need in accomplishing one or more business capabilities and the 
common skills and functionalities required to accomplish these business 
capabilities.

In this example, the history functional area is based on the 
business functional areas for selling, delivering and 
command.

 For more information on the use of a business functional area, see 
Creating an internal or external business functional architecture area.

• the business components.

 A business function is a conceptual unit of the division of 
responsibilities in an enterprise. It is used to structure the management 
of information processing, energy, and equipment produced or used. 
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Business functions define the skills and the functionalities necessary to 
the enterprise to fulfill its mission.
 For more details on business functions, see Describing Business 
Functions.

With HOPEX IT Business Management , communications are based on:
• access points: service points and request points.

 A service point is a point of exchange by which an agent offers a 
service to potential customers.

 A request point is a point of exchange by which an agent requests a 
service from potential suppliers.
 For more details on service interactions between components, see 
Managing service points and request points.

• service interactions

 A Service Interaction represents an interaction for service purpose 
between entities in a specific context inside or outside a company. 
These entities can be enterprise org-units, applications, activities or 
processes, as well as external org-units. The content of this interaction 
is described in a service interface.
 For more details on service interactions between components, see 
Managing Service Interactions.

Managing service points and request points
A business business functional area is created to ensure one or more services. These 
services are represented by service points. The service is requested according to 
precise terms defined by an service interface assigned to the service point.

 A service point is a point of exchange by which an agent offers a 
service to potential customers.

 A Service Interface is a template of a contract between entities 
(organizational, IT …). The contract is described by available operations 
which can be triggered trough messages exchanged by roles (vendor, 
buyer..).
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A request point is used to represent the use of an external service.
 A request point is a point of exchange by which an agent requests a 
service from potential suppliers.

The service is requested according to specific terms that are defined by a service 
interface assigned to the request point.

Components that issue a request are linked to the request point by a service 
interaction. 

In the example, the request point that represents the 
"External delivery" is linked to the "Sales and deliveries" 
business functional area by a service interaction.

Creating a service point or a request point

The process for creating a service point or request point is identical. 

To create a service point:
1. In the diagram insert toolbar, click Service Point.
2. Position the object at the edge of the architecture frame.

A creation dialog box opens.
3. Click the arrow to the right of the Service Interface field to define the 

service interface enabling activation of this service point, and select, for 
example, Connect Service interface.
A query window opens.

4. Select the service interface associated with this service point.
5. Click Next.

A dialog box opens proposing a list of the service interface roles that can 
be associated with the service point.

 This second dialog box is not proposed if there is only one 
candidate role that can be associated with the service point.

6. Select the role that interests you and click OK.
The service point appears in the diagram.

To change the service point name:
1. Click the name of the service point and press key F2.
2. Enter the new name used when specifying service interaction points.

Managing Service Interactions
A Service Interaction represents the exchange of information between architecture 
components.

 A Service Interaction represents an interaction for service purpose 
between entities in a specific context inside or outside a company. 
These entities can be enterprise org-units, applications, activities or 
processes, as well as external org-units. The content of this interaction 
is described in a service interface.

The content of a service interaction is described by an service interface.
 A Service Interface is a template of a contract between entities 
(organizational, IT …). The contract is described by available operations 
which can be triggered trough messages exchanged by roles (vendor, 
buyer..).
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Creating a Service interaction

To create a service interaction:
1. In the objects toolbar of the diagram, click Service interaction. 
2. Draw a link between the two communication entities.
3. In the Add service interaction window, specify the service interface you 

wish to use.
 You can also create a new service interface, see Creating a service 
interface from a service interaction.

4. Click OK.

Creating a service interface from a service interaction 

You can create a service interface:
• from a library,
• from a service interaction in a diagram.

To create a service interface, in a diagram, from a service interaction:
1. In the objects toolbar of the diagram, click Service interaction.  
2. Draw a link between the two communication entities.
3. In the Add service interaction window, click the arrow at the right of the 

field Service interface and select New.
The creation window appears.

4. Enter the service interface name in the Name field.
5. Click OK.

The service interaction and the service interface are created.

Describing Business Functions

 A business function is a conceptual unit of the division of 
responsibilities in an enterprise. It is used to structure the management 
of information processing, energy, and equipment produced or used. 
Business functions define the skills and the functionalities necessary to 
the enterprise to fulfill its mission.

Accessing the list of business functions
To access the list of Business Functions from the Inventories navigation menu:

1. Select Business Architecture > Business Functions.
The tree of business functional areas appears.

2. Expand the folder of the business functional area that interests you.
The list of business functions connected to the concerned business 
functional area appears.
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Business properties
The Characteristics properties page of a business function provides access to:

• its Owner, by default on creation of the business function, the current 
enterprise.

• its Name,
• the text of its Description.
• its Owned Realizations 

 For more details on creating a business capability, see Creating 
Fulfillment of a Business Capability.

With HOPEX IT Business Management , a business function is described by the 
following pages:

• the Required Abilities page is used to specify a list of skills and 
functionalities required by the business.

 For further details, see .For further details, see Describing 
functionalities.

• the Performed Process page, which provides access to the value 
streams executed.

Describing Business Partners

 A business partner designates a third-party who is in relation with 
the enterprise within the framework of a given business architecture 
environment. Examples: private sector client, regulatory organization, 
supplier.

Accessing the business partners list
To access the list of Business Partners from the Inventories navigation menu:

 Select Business Architecture > Business Partners.
The list of business partners appears in the edit area.

The properties of a business partner
The Characteristics properties page of the business partner provides access to:

• its Owner, by default on creation of the business partner, the current 
enterprise.

• its Name,
• Its business partner group, see  Drawing up the Roadmap,
• the text of its Description.
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With HOPEX IT Business Management , a business partner is described by:
• the Service and Request Points page, which specifies the services 

expected or delivered by a business partner.
 For more information on these service points and request points, 
see Managing service points and request points.

• The Usage page provides access to the business function architecture 
environments that use the described object, see Describing a Business 
Architecture Environment.
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DESCRIBING AN ENTERPRISE ARCHITECTURE

The enterprise architecture is described through the architecture description of each 
transformation stage that represent the architecture evolution over the time. 

A transformation stage is defined by a number of components that represent its 
architecture. This consists of:

• The lists of exhibited business capabilities;

 An exhibited business capability is exhibited by an Enterprise Stage 
with quantified measure (KPI) and potential geopolitical scope (Site) for 
a defined market segment (Business Partner).
 For more details on how to associate an exhibited business 
capability with a transformation stage, see Creating an exhibited 
business capability.

• the business architecture environment;

 A business architecture environment represents the relationships of 
a business functional area with its partners.
 For further details, see .For further details, see Describing a 
Business Architecture Environment.

• the solution building block environments.
 For more details on how to access this information from an 
enterprise or a transformation stage, see Describing physical solutions.

Describing the operating architecture
The business architecture environment contains the elements that define the 
enterprise model (operational model) for the current stage.

 For more details on the managing the business architecture 
environment, see Managing a Business Architecture Environment.

The elements constituting the enterprise operational model are:
• the enterprise ecosystem defined by the service interactions with the 

partners, 
• the business function architectures,
• the business functions.

To describe the business architecture environment for a transformation stage:
1. Open the Architecture Description property page of the 

transformation stage.
2. In the Functional Architecture section, click the right arrow of the 

Operational Model field.
3. Click Connect a business architecture environment.

A selection window opens.
4. Select the business environment architecture that interests you and click 

Connect.
The business architecture environment is connected to the transformation 
stage.
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Describing physical solutions
The possibilities to describe physical solution depend on the product licenses that 
you have, for example:

For example, with HOPEX IT Architecture, you have access to:
• Logical Application System Environments
• Application System Environments 
• Resource Architecture Environments.

To connect technical or application architecture building blocks to an transformation 
stage:

1. Open the Architecture Description property page of the 
transformation stage.

2. In the Functional Architecture section, click Connect.
A selection window opens.

3. Select the environment type concerned and click Find.
 A business architecture environment represents the relationships of 
a business functional area with its partners.

 A resource architecture is the combination of physical and 
organizational assets configured to supply a capability.

 An application system environment allows presenting the other 
application systems, applications or microservices with which this 
application system can interact.

 A logical application system environment presents a logical 
application system use context. It describes the service interactions 
between the logical application system and its external partners, which 
allows it to fulfill its mission and ensure the expected functionalities.

4. Select the environment that interests you and click Connect.
The environment is connected to the transformation stage as well as to all 
the building blocks that it comprises.
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DRAWING UP THE ROADMAP

A number of functionalities are available to display and analyze an enterprise’s 
transformation strategy and the stages of its deployment. 

Each transformation stage is positioned in the enterprise according to their period, 
in order to define the transformation roadmap for the enterprise underway.

 For more details on transformation stages, see Defining 
Transformation Stages.

The transformation stages dates are presented in the colons of the dedicated report 
of the enterprise.
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Drawing up the Roadmap

The strategic components of the enterprise and its transformation stages are 
displayed in another enterprise report.

 For more details on strategic elements, see Identifying Strategic 
Transformation Elements.
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MANAGING IT ASSETS

HOPEX IT Business Management integrates the application inventory and evaluation functions 
of HOPEX IT Portfolio Management (ITPM).

Drawing up an Application Inventory
HOPEX IT Business Management offers the possibility to describe simple 
applications or more complex applications via the use of application systems.

The application inventory phase consists of collecting information from different 
viewpoints: descriptive, functional, financial, technical, etc.

See Drawing up an Application Inventory in the ITPM documentation.

Drawing up a Technology Inventory
Similarly to applications, HOPEX IT Business Management enables to draw up 
an inventory of available technologies and to collect information according to 
different criteria.

See Drawing up a Technology Inventory in the ITPM documentation.

Managing the Data Used in the Application Assets
You can inventory data and link them to the applications that use them.

See Managing the Data Used in the Application Assets in the ITPM documentation.
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Evaluating Application Assets
Each application manager can evaluate applications for which he/she is responsible 
based on three criteria: business, functional and technological. See Evaluating 
Application Criticality.

The Portfolio Manager can evaluate the application assets he/she supervises by 
creating an application portfolio and associating with it additional evaluation criteria.

See Evaluating Application Assets in the ITPM documentation.
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IMPORTING OBJECTS IN HOPEX IT 
BUSINESS MANAGEMENT 

HOPEX IT Business Management  provides an Excel file template for bulk
importing objects into the repository.

Downloading the Excel Import Template
The Excel import template is available in the HOPEX Store.

To download the file:
1. Connect to the HOPEX Store.
2. Click Modules.
3. Search for the ITBM Excel Import Template.
4. Select the template and click Download.

Template description
The file enables bulk import of the following object types:

• Strategy objects: enterprises, goals, strategies.
• Transformation objects: stages, objectives, tactics, exhibited business 

capabilities.
• Business architecture objects: value streams, value stages, business 

function areas, business functions, business partners.

The different types of objects concerned are presented in dedicated sheets.
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The _README sheet details the object import:
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Project Portfolio Management



126 HOPEX IT Business Management
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INTRODUCTION TO PROJECT PORTFOLIO 
MANAGEMENT

Project Portfolio Management (PPM) is an approach used by an organization to analyze the potential
return of a set of projects. Its primary aims are to:

• Control the suitability of projects with respect to the strategic objectives 
of the organization.

• Ensure consistency between the projects and the organization's 
capability.

This approach examines the risks, the available funds, the probable duration of a project and the
expected results. A group of decision-makers assesses the benefits and the priority to be given to
each project to determine the best way to invest the capital and the human resources of the
organization.

In HOPEX IT Business Management  and HOPEX IT Portfolio Management solutions, the
HOPEX Project Portfolio Management option offers a set of features to:

• Submit and assess the project demands and candidate projects.
• Validate the candidate projects: the project demand goes through a 

validation process that results in a project creation. 
• Select and define the project priority: a limited list of projects is drawn 

up according to selection criteria (strategic, financial, etc.) 
• Analyze and arbitrate the projects.
• Follow project progress.

 For more details on HOPEX features, see the HOPEX Common 
Features guide which presents features common to all HOPEX 
products. 
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THE SCOPE COVERED BY PPM

The HOPEX Project Portfolio Management option covers the following concepts:
• The management of project demands and candidate projects
• Project portfolio management

Prerequisites for Creating Projects

Importing the PPM module
To be able to use functionalities of HOPEX Project Portfolio Management, you
must first import the PPM module.

To import a module in HOPEX, see "Importing a module in HOPEX" chapter of the
HOPEX Administration guide.

It contains: 
• The following portfolio types:

• project demand portfolios
• candidate project portfolios and projects in progress

• The states of the project:
• Project demand
• Candidate project
• Ongoing project

• The two criteria weighting models:
• PPM value & risk weighting model
• PPM flat weighting model

Defining project domains
Each project belongs to a project domain.

Before creating a project, you must create the corresponding domain.

See Defining Project Domains.

Managing Project Demands and Candidate Projects

Identifying and documenting demands 
The demand manager can create a project demand or research a project demand
created from an idea.

 For idea creation, see Submitting and evaluating ideas.



129

Introduction to Project Portfolio Management
The Scope Covered by PPM

The demand manager can document the project charter and its business case. He/
she can in particular:

• Define the scope of the project in terms of deliverables or impact on the 
capabilities of the enterprise,

• Define a forecast budget,
• Identify the project risks, 
• etc.

Assessing demands 
The demand manager can assess a project demand:

• According to qualitative and quantitative criteria defined in the project 
demand portfolio.

• Through the qualitative assessment (business value level, strategic 
alignment, cost, global risk level), which is used to calculate a global 
score for the project and compare the projects between each other.

Validating demands 
The demand manager can submit a project demand to the demand approver.

The approver can validate or reject the project demand.

A validated demand leads to the creation of a candidate project, submitted for
assessment to project portfolio managers. 

Assessing candidate projects
In the same way as demands are assessed, candidate projects can be assessed:

• According to qualitative and quantitative criteria defined in the project 
demand portfolio.

• Through the qualitative assessment (business value level, strategic 
alignment, cost, global risk level), which is used to calculate a global 
score for the project and compare the projects between each other.

Validating candidate projects
The approver can validate or reject the candidate project.

When a candidate project is validated, it takes on the status of a project in progress.

Following-up ongoing projects
The project portfolio manager assigns a manager to the project, responsible for
follow-up of the progress of the project. You can view the calendar and the progress
of a project in a report.
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Selecting the projects and defining priorities
Portfolio managers and administrators define the project domains that determine
the strategic perspectives of the organization in which the projects are classified (for
example: "Business projects", "IT projects").

Arbitration portfolios are automatically associated with the domains of the projects
created. They group the projects in the domain, classifying them according to their
type (project demands, candidate projects and ongoing projects).

In an arbitration portfolio, the project portfolio manager and approver can create
analysis portfolios; they represent a sub-set of projects in the arbitration portfolio
and can be assigned to a specific project portfolio manager.

In an arbitration portfolio or an analysis portfolio, the project portfolio manager can:
• Browse, in read-only, the criteria assessed at the project level (for 

example, the strategic alignment level, the risk level, the cost level and 
other attributes specific to the project).

• Assess the criteria specific to the portfolio (other than the project 
criteria).

• Generate project comparison reports (for example, bubble charts) based 
on these criteria.

Using an arbitration portfolio or an analysis portfolio, the project portfolio manager
can create scenarios.

In a scenario, the project portfolio manager can choose to select or not a given
portfolio line (which is different from the project validation), and note the impact of
this choice in dedicated reports.

Analyze and arbitrate portfolio projects
Using a portfolio, the project portfolio manager can generate analysis and
comparison reports to compare, for example, the accumulated risks or costs of a
given scenario.

The project portfolio manager can keep one scenario or a set of scenarios.
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ROLES IN HOPEX PROJECT PORTFOLIO MANAGEMENT

HOPEX Project Portfolio Management includes by default business roles with
specific rights and tasks.

They are part of the workflow associated with objects.

Demand Submitter

The demand submitter is the person who creates the demand (role created
automatically on demand creation).

Demand Approver 

The demand approver is responsible for validating the demand. The approvers can
be defined globally for a project domain or a portfolio, or on a project-by-project
basis.

Project Portfolio Approver 

The project portfolio approver is responsible for validating the demand. The
approvers can be defined globally for a project domain or a portfolio, or on a project-
by-project basis.

Project Leader 

The project leader is responsible for project completion and follow-up.

Project Portfolio Manager 

The portfolio manager is responsible for examining candidate projects in their
entirety and approving or rejecting the candidate projects submitted by the demand
managers. He/she is responsible for assessing the risk level, the strategic alignment
and the costs/benefits of the project in the project portfolio, and to thus define the
relative benefits of the candidate projects and projects in progress.

Project Stakeholder

Project stakeholder is the role of an individual, team, or organization that represents
their interests in the project outcomes.
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DEFINING ENTERPRISE PROJECTS

According to the PMI® standard PMBOK, a project is a "temporary enterprise chosen with the aim
of creating a product, a service or a unique result".

A project has a purpose in terms of an acquired, improved/extended or abandoned capability. A
project generates project deliverables. 

With HOPEX Project Portfolio Management option, you can:

• Submit project demands
• Define project content
• Assess project demands and candidate projects.
• Follow project progress

The points covered here are:

 Defining Project Domains
 Managing Project Demands
 Managing Candidate Projects
 Assessing a Project
 Follow-up of Ongoing Projects
 Project Analysis Reports
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DEFINING PROJECT DOMAINS

A project can be defined in a given project domain.

The project domain defines the sector and the application scope of the project (for
example: business function, IT, search and development). It is the container of a
set of projects on which an arbitration can be conducted.

Two arbitration portfolios are automatically associated with a project domain: 
• demand portfolios 
• candidate project portfolios and projects in progress

For more details on arbitration portfolios, see Grouping Projects by Portfolio.

Creating a Project Domain
To create a project domain:

1. Click the Projects > Project Domains navigation menu.
2. In the edit window, click New.

The create a project domain window appears.
3. Enter the name of the domain.
4. Click OK.

When you create a domain, the two types of portfolios that correspond to the
different project statuses (project demands, candidate projects and projects in
progress), are also created. They are visible in the Project Portfolios. 

Assigning a Domain to Persons
It is possible to define particular roles for users on a domain; these roles are then
valid for all the projects in the domain.

To assign a person to a domain: 
1. Display the domain properties.
2. Click the Assignment page.
3. Click New.
4. In the window that opens, select the person or person group.
5. Select their role. You can define the following roles:

• Demand Approver
• Project Portfolio Approver
• Project Portfolio Manager

6. Click OK.
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MANAGING PROJECT DEMANDS

The demand creators and the demand managers can create new project demands
and view the project demands that were generated using ideas.

Demand managers can document the project charter as well as the business case.
They can in particular define the scope of the project in terms of deliverables and
the risks associated with the project.

Demand Management Process
The project demand process is broken down into three parts:

• Creating the demand
• Evaluating the demand
• Approving or rejecting the demand

Creating a Project Demand
To be able to create projects, you must import the PPM module. See Prerequisites
for Creating Projects.

You must also have created a project domain. See Defining Project Domains.

To create a project demand:
1. Click the Projects > Projects navigation menu.
2. In the edit area, click the Projects tab.
3. Display “All projects”.
4. Click New.

The project creation window appears.
5. Select the "Demand" project type and click Next.
6. Specify:

• The project name 
• the owner project domain 
• the project code (optional)
• the planned start date
• the planned end date

7. Click OK.

Defining the Project Charter
To define the charter for a project:

1. Click the Projects > Projects navigation menu.
2. In the edit area, click the Projects tab.
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3. Display “All projects”.
4. Click the project concerned to open its properties.
5. In the project properties window, click the Project Charter page.

The definition of the project charter includes:
• The identification:

• project name
• project owner domain 
• project code (optional)
• project manager
• state (life cycle status) Defined automatically.
• status (workflow step). Defined automatically.
• description (comment)

• The project category or categories. 
• The initiating ideas: ideas that have inspired the project. 

Defining the Business Case of a Project 
To define the business case for a project:

1. Click the Projects > Projects navigation menu.
2. In the edit area, click the Projects tab.
3. Display “All projects”.
4. Click the project concerned to open its properties.
5. In the project properties window, click the Business Case page.

Transformation objective
A project has an objective with respect to the capabilities of the enterprise (as
defined in a capability map); it can:

• deliver the means to acquire a new capability (innovation) 
• extend the coverage of a capability already held (improvement) 
• restrict or abandon the coverage of an existing capability 

(rationalization).

To add a transformation objective to the project:
1. In the Transformation Objective section, click New.

The creation dialog box for a transformation objective opens.
2. Specify:

• its name
• the transformation type (Innovation, Improvement, Rationalization)
• the capability transformed

3. Click OK.

Project deliverables
A project deliverable defines the result of a project and its impact on or its
contribution to the architectural solution landscape of the enterprise.
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It is defined by a solution block (example: an organization, an application, an
infrastructure element) delivered by the project in the target architectural
landscape. Within the framework of a project deliverable, a block can be:

• New: the project delivers a new block to the target architectural 
landscape.

• Updated: the project modifies an existing block in the current landscape, 
for example by extending its lifecycle,  and delivers the updated version 
to the target architectural landscape.

• Deleted: the project deletes an existing target architectural block, which 
will therefore not be part of the target landscape.

To add a deliverable to the project:
1. In the Deliverables section, click New. 

The window for creating a deliverable appears.
2. Specify if you want to:

• create a new block
• update an existing block
• decommission an existing block

3. Click Next.
4. Specify:

• the deliverable name
• the deliverable type
• the deliverable production dates

5. Click OK.

Deliverable production dates

To model component change scenarios for elements in your portfolio without
impacting the life of components in place, you will associate an object life with the
deliverables.

 The object life is a set of time periods representing the updated 
calendar of object life cycle states.

When the project is terminated (via the corresponding workflow command), the life
cycle of deliverables is automatically transferred to the objects concerned.

To define the life of a project deliverable:
1. In the Deliverables section, select the deliverable in question.
2. Click Properties.

The properties window of the deliverable appears.
3. Click the drop-down list then Object Life.
4. Click New.

The creation of object life dialog box appears.
5. Specify the following characteristics:

• the life cycle  that defines the list of possible object states.
 For more information on proposed life cycles, see Defining Life 
Cycles.

• a Begin Date and an End Date which enable positioning of the object 
life in time.

6. Click OK.
A Gantt char is used to view the steps of the life cycle of a deliverable.
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On the project, the Gantt char for the lifecycle of the project deliverables
details the lifecycle of the project deliverable. 

Project dependencies
A project can depend on other projects:

• In a "positive" sense: a project can have another project as a 
prerequisite, of which one of the deliverables is necessary to build a 
deliverable of the dependent project (this is the equivalent of an AND 
logic: both projects must be conducted jointly to reach the final result).

• In a "negative" sense:  two projects can be concurrent and mutually 
exclusive (this is the equivalent of the OR logic: only one of the projects 
must be managed, not both).

To associate a dependency with the project:
1. In the Project Dependencies section, click New.
2. Specify:

• The name of the dependency
• The project required
• The type of dependency: "Exclusive" or "Prerequisite".

3. Click OK.

Project costs
The specification of the costs of a project take place through the cost lines.

One or more cost lines can be associated with a project.
 A cost line enables identification of cost kind and type. 

A cost line is characterized by:
• a type: operating or capital;
• a nature: infrastructure (for a deployment), license (for an application), 

service, manpower;
• state of the cost line .

Associated with a cost line can be:
• a periodic expense
• one or several fixed expenses

Creating a cost line

To create a cost line for a project:
1. Expand the Costs section.
2. Under Cost Line, click New.

The Creation of a cost line box opens.
3. To create a single cost line, select option Create only one cost line.
4. Click Next.
5. Specify the Name of the cost line.
6. Select the Cost Type. 
7. Select the Cost Nature.
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8. Select the state of the cost line. 
 The states proposed in the drop-down list are the states of the life 
cycle associated with the object life.

9. Click Next.
10. Define the periodic expense.

 Fixed expenses, which can be multiple, are defined separately. For 
more details on fixed expense creation, see Adding a fixed expense.

11. Click OK.
The new cost line appears in the Cost Line.

Adding a fixed expense

To associate a fixed expense with a cost line:
1. In the Cost Line section, select the cost line that interests you.
2. In the Cost Line Expensessection, click New.

The Creation of Expense dialog box opens.
3. Specify:

• the Name of the expense
• the Date of the expense,
• the Amount of the expense.

4. Click OK.
The new expense appears in the Fixed Expenses section.

Project benefits
You can specify:

• the Qualitative Benefits: to be entered as a comment.
• the Financial Value of the project: in currency = project NPV (net 

present value), calculated outside the tool according to the standards of 
the enterprise. 

• the Return on Investment:  calculated attribute, as a %
(Financial value - Budget) / budget

• the Forecast Return on Investment: calculated attribute, as a %
(Financial value - Estimated total cost) / Estimated total cost

• the Actual Return on Investment: calculated attribute, as a %
(Financial value - Real total cost) / Real total cost

Project risks
With HOPEX IT Portfolio Management, you can identify the risks linked to a
project. Each risk is associated with a single project.

To create a project risk:
1. Expand the Risk section.
2. Click New.

The risk creation dialog box appears.
3. Enter the name of the risk and the type of risk (cost, deadline, quality).
4. Click OK.

To assess risks, see Assessing the Risks of a Project.
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Assigning a Project to Persons 
The persons who can be assigned to a project are those who perform one of the
following business roles:

• Demand Approver 
• Requester
• Project Manager
• Project Holder
• Project Portfolio Approver
• Project Portfolio Manager 
• Project Stakeholder

The author of the idea and the innovation manager can assign persons to a project.

To assign a person or a person group to a project.
1. Click the Projects > Projects navigation menu.
2. In the edit area, click the Projects tab.
3. Display “All projects”.
4. Click the project concerned to open its properties.
5. In the project properties window, click the Assignment page.
6. Click New.
7. In the dialog box that appears, select a Person or a Person Group, as 

well as their Business Role. 
8. Click OK.

Repeat this procedure to assign other persons to the project.

Validating or Rejecting a Project Demand
After assessment, the demand manager can submit the project demand to a
demand approver.

 For more details on assessment, see Assessing a Project.

The approver approves or rejects the demand.

Validating a project demand
A validated project demand becomes a candidate project; the state of its life cycle
is automatically modified and it is transferred to the portfolios of the candidate
projects in the domain to which it belongs.

Rejecting a project demand
A rejected project demand remains in the list of projects, with the "Demand
rejected" status. It can be archived. 
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MANAGING CANDIDATE PROJECTS

Candidate Project Management Process
The management process of a candidate project is broken down into three parts:

• Creating the Project
• Assessing the project
• Defining the scenarios
• Approving or rejecting the project

Creating a Candidate Project
A project demand validation leads to a candidate project.

The project portfolio manager can create a candidate project directly without going
through the demand management phase, or an ongoing project (in other words
validated) if needed.

To be able to create projects, you must import the PPM module. See Prerequisites
for Creating Projects.

You must also have created a project domain. See Defining Project Domains.

To create a project candidate:
1. Click the Projects > Projects navigation menu.
2. In the edit area, click the Projects tab.

Use the drop-down list to display:
• all projects
• projects by status (candidate projects, ongoing projects)
• the projects assigned to you

3. Display all projects.
4. In the demands for the edit area, click New.

The window for creating a project appears.
5. Enter the name of the project.
6. Select the "Candidate" project type.
7. Click Next.
8. Specify:

• the owner project domain
• the project code (optional)
• the planned start date
• the planned end date
• the project leader

9. Click OK.

See also: Creating a Project Demand.
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Completing the Candidate Project Definition
Once the project is created, you can complete its properties in the same way as for
a project demand. 

See:
• Defining the Project Charter
• Defining the Business Case of a Project
• Assigning a Project to Persons

See also:
• Assessing a Project

Validating or Rejecting a Candidate Project
After assessment, the demand manager can submit the candidate project to the
project portfolio approver. 

This presupposes that an approver has been previously linked to the project,
portfolio or project domain in question.

 To assign a project to a person, see Assigning a Project to Persons.

 For more details on assessment, see Assessing a Project.

The project portfolio approver approves or rejects the project.

Validating a candidate project
A validated candidate project becomes an ongoing project; its lifecycle status is
automatically changed.

Rejecting a candidate project
A rejected candidate project remains in the list of projects, with the "Project
rejected" status. It can be archived. 
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ASSESSING A PROJECT 

A first assessment of a project takes place with the definition of the business case
of the project; you can specify the deliverables, the dependencies with other ideas
or risks, the costs, the benefits, the risks.

The business case elements can be defined on project demand, and subsequently
completed. For more details, see Defining the Business Case of a Project.

Once the project characteristics are defined, an evaluation tool facilitates the
selection of projects and helps define priorities.

The demand managers can assess the projects:
• At the level of the project, via:

• the qualitative review of the project (business value, level of strategic 
alignment, etc.) 

• the assessment of the project risks
• according to qualitative and quantitative criteria defined in the project 

portfolio. See Assessing Portfolio Projects.

Assessing a Project
An assessment can concern a project demand or a candidate project.

To assess a project:
1. Click the Projects > Projects navigation menu.
2. In the edit area, click the Projects tab.
3. Display all the projects.
4. Click the project in question to open its properties.
5. In the properties window, click the Project Assessment page.
6. In the Assessment section, click New Assessment.

An assessment line appears.
7. In each corresponding column, specify:

• the business value level 
• the strategic alignment level
• the cost level
• the global risk level

To validate the assessment, select the assessment line and click Validate
Assessment.

 The Project Note attribute visible on a portfolio is calculated 
automatically based on these values.
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Assessing the Risks of a Project
Assessing the risks of a project can start on project demand. This can take place
globally on the project (in the Project Assessment) or for each risk associated with
the project (in Risk Assessment).

To assess the risks of a project:
1. Click the Projects > Projects navigation menu.
2. In the edit area, click the Projects tab.
3. Display all the projects.
4. Click the project in question to open its properties.
5. In the properties window, click the Risk Assessment page.
6. Click New Assessment.
7. In the window that appears, select the risks to be assessed. 

• Some
• All

8. Click OK.
The assessment appears in the properties window.
You can define:
• TheImpact: characterizes the impact of the risk when it occurs.
• The Likelihood: characterizes the probability that the risk will occur.
• The Inherent Risk Level: The inherent (or gross) risk indicates the 

risk to which the organization is exposed in the absence of measures 
taken to modify the likelihood of occurrence or impact of this risk. This 
is the result of multiplying the impact value and the likelihood value 
before taking account of risk prevention or reduction measures.
In summary, an inherent risk = impact x likelihood
It is calculated automatically.

• The Control Level: The Control level characterizes the efficiency level 
of control elements deployed (controls) to assess the risk.

• The Net Risk Level: the residual (or net) risk indicates the risk to 
which the organization remains exposed after management has 
processed the risk. This is the difference between the Inherent Risk 
and the Control Level. It is calculated automatically.

See also Assessing the Risks of a Project.
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FOLLOW-UP OF ONGOING PROJECTS

Process for Follow-up of Ongoing Projects
Ongoing projects result from the validated candidate projects.

 A project portfolio manager can also  directly create an ongoing 
project. 

The project portfolio manager assigns a manager to the project, responsible for
follow-up of the progress of the project.

Project follow-up consists of the following steps:
• Starting the project
• Specifying the project milestones
• Updating the project progress
• Terminating the project

Starting a project
The project portfolio manager and project managers can start a project.

To start a project:
1. Click the Projects > Projects navigation menu.
2. In the edit area, click the Projects tab.
3. In the drop down list, select the list of ongoing projects.
4. Click the icon of the project concerned and select Project Workflow 

(Project to Start) > Start the Project.
A dialog box appears:

5. Enter a comment if required and click OK.
6. Specify the effective start date of the project and click OK.

The project workflow status switches from "To be started" to "Ongoing
Project".

Specifying the Project Milestones
Between the scheduled start and end dates, intermediate milestones can be defined
and associated with deliverables.

 A project milestone defines an intermediate delivery step in the life 
cycle of the project life. A project deliverable can be associated with a 
project milestone if it is delivered during the project and on the project 
date.
 Associating a project deliverable with a milestone does not affect 
automatic initialization of its life cycle; it can be subject to a manual 
modification if appropriate. 
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Within the framework of project progress follow-up, you can define the level of
progress for each milestone.

To add a milestone to a project:
1. Click the Projects > Projects navigation menu.
2. In the edit area, click the Projects tab.
3. Display all the projects.
4. Click the project in question to open its properties.
5. In the project properties window, click the Project Milestones page.
6. In the Milestones section, click New. 

The window for creating a milestone appears.
7. Specify:

• The local name
• The scheduled date of the milestone
• A comment if required

8. Click OK.

Assessing the Progress State of a Project
You can indicate the progression of a project in progress and the different
milestones defined on a project.

Example
My project is 25% complete at this time.
I have reached the first milestone, so I can put it at 100% 
this same day.

Updating the project progress 
To update the progression of a project in progress:

1. Click the Projects > Projects navigation menu.
2. In the edit area, click the Projects tab.
3. Display all the projects.
4. Click the project in question to open its properties.
5. In the properties window, click the Execution Monitoring page.
6. In the History of Project Progression Updates section, click New.

The progress rate creation window appears.
7. In the Progress Rate section, specify:

• the progress rate percentage
• the progress rate date
• the assessment of the progress rate (On time or Late)
• the forecast end date
• the amount spent
• the remaining forecast amount

8. Click OK.

Viewing the timeline of a project
A report enables you to view the timeline of the project.
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To access the Reports tab:
1. In the project properties, select the Reports page.
2. Select the "Lifecycle Gantt Chart for Project Deliverables" report.

The project calendar appears.

Putting a Project on Stand-by/Canceling a Project
For a project in progress, you can:

• Cancel the project: the project remains visible but cannot be recovered 
Update the project on stand-by: the status changes from "Project in 
progress" to "Project on stand-by". Subsequently, you can:
• Recover the project on stand-by
• Cancel the project on stand-by

Terminating a Project 
Terminating a project updates the lifecycle of the objects attached to the project.

To terminate a project in progress:
1. Click the icon of the project then Project Workflow (Ongoing 

Project)  >  Terminate the Project.
A message prompts you to confirm the changes to the lifecycle of the
architecture building blocks concerned.

2. Click OK to confirm.
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PROJECT ANALYSIS REPORTS

Dynamic reports are provided by default for projects; they are used to analyze
project content from different angles as well as their impact on the business
capabilities and architecture building blocks.

Reports on the Project Content
Embedded reports on a project are visible in the Reports page of the project
properties window.

Project Costs
This report details the project costs for a given period and by cost type (labor,
infrastructure, etc).

Its input data concerns the costs defined in the project properties (on the Business
case page).

 To define the costs of a project, see Project costs.

It is possible to configure the cost consolidation period via the Time Period
parameter; for example a sub-total of project costs is possible per quarter.

Project and Deliverable Timeline Gantt Chart 
This report presents the lifecycle of deliverables in the project schedule.

Its input data concerns the production dates of the deliverables as well as the
milestones defined for the project.
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The progress of the project and the projected deadlines declared during the follow-
up of the execution of the project are also reported on the graph.

See also: 
• Project deliverables
• Specifying the Project Milestones
• Assessing the Progress State of a Project
• Analyzing the Road Map for Portfolio Projects.

Project KPIs
This report analyses the key indicators of the project. It collects the following data:

• The progress and any delays in the project (defined on the Execution 
Follow-up page for projects in progress)

• The budget and the costs defined on the project properties (on the 
Business case page).

• The Return on Investment (calculated)
• Cost variance (calculated)
• The project risks

Progression and delays

Project progression and delays are defined using the last update performed on the
project. 

 For more details, see Assessing the Progress State of a Project.
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Budget and costs

A bar chart presents the following data: 
• The planned budget, input manually.
• The total forecast cost, calculated according to the last update of the 

project (amount spent + remaining to be spent)
• The effective cost, input manually at the end of the project.

 The "Total cost" displayed in the Costs section is calculated based 
on cost lines; it is for information purposes and is not used in the report 
calculations.

For information on project cost input, see Project costs.

Return on investment 

A bar chart presents the following data: 
• Forecast ROI (as a percentage)
• Effective ROI (as a percentage)

Calculation of the ROI = (profit - budget) / budget.

Forecast variance and effective variance

A gauge displays the following data:
• Forecast variance = (total forecast cost - budget) / budget, as a 

percentage.
• Effective variance = (effective cost - budget) / budget, as a percentage. 

Risks

A bar chart displays the risks per risk level (low, high, etc.)
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Project summary
This report offers a summary of the characteristics of the project, that is:

• The project charter
• The persons responsible
• The Business case
• The execution follow-up
• The key project indicators.

Impact Reports for Projects
The Project Portfolio Manager can use a report to analyze the impact of
transformation projects on business capabilities.

This report aims to identify, for the business capability map of a given Enterprise
phase, the relevant transformation projects and their impact on capabilities,
according to the objective of the transformation projects. 

To generate the impact report of transformation projects:
1. Click the Reports navigation menu.
2. In the edit area, click Create a report.
3. Search for report type "Projects Impact on Capability Map".
4. Create a report of this type.

Report parameters

The report takes as input:
• A capability map. The list of capability maps included in an enterprise 

phase is proposed by default.
• A project portfolio.

Filters allow you to customize the display of objects in the report:
• Enable Purpose Type Criterion: you can display or hide the purpose 

type of the projects. This option is enabled by default, with the form "Fill 
color": a color highlights the capabilities and projects in the report 
according to the type of purpose of the projects.

• Capability Filter: you can only display capabilities that are covered by 
solution building blocks. Criteria also allow you to represent the 
functionalities associated with capabilities in a specific shape (circle, 
triangle, etc.).

• Project Filter: you can display only on-going projects. Criteria also 
allow you to display the assessment levels defined on the projects 
(business value, cost, etc.).

 Other filters can be added in customization (by specific queries 
connected to the type).

Report Results

The report presents two chapters:

Transformation Projects Impact on Capability Map



152

By default, projects are displayed in the relevant capability boxes and highlighted in
a color that depends on the type of transformation purpose. 

• Innovate -> green 
• Improve -> yellow 
• Rationalize -> red 

Capabilities are highlighted in a color depending on the associated transformation
purposes. 

• Majority of innovation -> green 
• Majority of improvement -> yellow 
• Majority of rationalization -> red 

Enterprise Stage and Transformation Projects

This chapter displays in a table the projects that are not mapped in the capability
map selected at report entry.
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They correspond to the following elements:
• projects that produce new capabilities in the "target" capability map
• projects that do not achieve any capability 
• projects that achieve capability but are not declared in the enterprise 

phase.
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PROJECT PORTFOLIO MANAGEMENT

Whereas project management aims to focus on scheduling and executing an individual project,
project portfolio management analyzes all projects in progress or potential projects and their
viability in reaching the objectives of the enterprise.

The portfolio management process can be represented in three sub-steps:

• Project selection: a restricted list of projects is drawn up according to 
selection criteria (strategic, financial etc.). The projects are classified 
according to the strategic perspectives (the domains) used in the 
organization.

• Analysis and arbitration: the best project combination is defined to 
maximize the objectives and the restrictions of the portfolio.

• Follow-up: the portfolio's performance indicators ensure the alignment of 
the portfolio with the strategy of the organization.

The points covered here are:

 Grouping Projects by Portfolio
 Assessing Portfolio Projects
 Analyzing and Arbitrating Portfolio Projects
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GROUPING PROJECTS BY PORTFOLIO

Grouping projects by portfolio summarizes the information relating to different
projects to facilitate decision-making.

Portfolio Types
There are two types of project portfolios:

• Arbitration portfolios, created automatically, which are divided into two 
groups:
• project demand portfolios
• candidate project and ongoing project portfolios, used to compare 

candidate projects with ongoing projects
• Analysis portfolios you can create later and which make up sub-sets 

within the arbitration portfolios.

Arbitration portfolio
Project arbitration portfolios group all the projects created according to their
domain.

When you create a project domain, two types of arbitration portfolios are created
by default and associated with this domain:

• Domain name - demand arbitration portfolio 
• Domain name - arbitration portfolio of candidate projects and ongoing 

projects

Each new project appears in the dedicated portfolio.

In an arbitration portfolio, the projects can be assessed and compared according to
a number of criteria: 

• project criteria: these come from information on the projects (for 
example, the costs) or the qualitative evaluation of the project (for 
example, the level of strategic alignment).

• portfolio criteria: criteria that can be defined at the portfolio level, above 
the project criteria.

See also: Defining Project Domains.

Analysis portfolio
You can create an analysis portfolio in an arbitration portfolio; it groups a sub-set
of parent arbitration portfolio projects. It can be defined to assign certain projects
to a specific portfolio manager.
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Portfolio Lines
For each project added to a portfolio, a portfolio line is created.

A project portfolio line is used to assess the project in the context of a portfolio. It
is linked to assessment criteria and provides the global note of the project in the
context of the portfolio.

See also Assessing Portfolio Projects.

Assigning a Portfolio to Persons 
The persons who can be assigned to a project portfolio are:

• the demand approver
• the portfolio manager
• the portfolio approver

For more information on profiles, see Roles in HOPEX Project Portfolio Management.
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ASSESSING PORTFOLIO PROJECTS

You can compare projects defined in a portfolio based on common criteria.

You can also add specific assessment criteria to the portfolio. 

Defining Portfolio Assessment Criteria 
You can compare the projects defined in a portfolio based on common criteria
associated with the portfolio. This is used in particular to define the priorities for
each project within the portfolio.

Some criteria are provided by default. You can create new criteria.

To create a criterion on a project portfolio:
1. Display the portfolio properties.
2. Click the Projects page.

The criteria appear in the Portfolio Criteria section.
3. Click New.

The dialog box for creating a criterion opens.
4. Specify:

• its name
• its type
• its length
• its format

5. Click OK.

Criteria weighting model
A criteria weighting model defines, for a set of criteria, the weight relative to each
of the criterion in the calculation of a weighted scoring criterion, used to
automatically calculate the rank of a project in the context of this portfolio with
respect to its score on these criteria.

Creating a Project Assessment
To create an assessment for the projects of a portfolio:

1. Display the portfolio properties.
2. Click the Project Assessment page.
3. Click New Assessment.
4. In the window that appears, select the projects to be assessed. 

• Some
• All
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5. Click OK.
An assessment line is created for each portfolio project with the different
criteria in a column.

6. To define the value of a criterion for a project, select the line of the 
project concerned and click in the criterion column.

Assessing common criteria
The criteria common to all projects are calculated automatically on the basis of
assessments performed specifically on the projects.

 For the qualitative evaluation of a project to appear in the portfolio 
properties, the assessment must have been validated at the project 
level.

Assessing criteria specific to the portfolio
For criteria created specifically for the portfolio, and are therefore not displayed in
the project properties, you can define them directly on the project assessment line
(drop-down list for a list or direct entry for a number/a text).
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ANALYZING AND ARBITRATING PORTFOLIO PROJECTS

In a portfolio, a number of projects can concern a single object to represent different
hypotheses, exclusive of each other, for the change in this object.

Scenarios can then be created by selecting a set of projects to be produced. The
different scenarios can be compared by means of specific reports:

Using a project portfolio, the project portfolio manager can generate scenario
analysis and comparison reports to decide which scenarios to keep or reject.

In an arbitration portfolio, if several scenarios have been selected for different
analysis portfolios, the project portfolio approver has access to an analysis tool
which provides an overview. This is used, for example, to determine whether
contradictory choices exist for a single project in the different scenarios selected.

Creating a Scenario
Using an arbitration portfolio or an analysis portfolio, the project portfolio manager
can create a number of scenarios.

A scenario defines, in a portfolio, a set of projects that can be implemented. It is
used to generate analysis reports to assess the impact of this set of projects. 

To create a scenario:
1. Open the project portfolio properties.
2. Click the Transformation Scenarios page.
3. In the Transformation Scenarios section, click New. 

The dialog box for creating a scenario opens.
4. Enter the name of the scenario and click OK.
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Defining the properties of the scenario
To define the properties of the scenario:

1. In the portfolio properties, in the Transformation Scenario page, 
move the mouse over the scenario in question and click the associated 
Properties button.

2. In the scenario properties, select the Characteristics page.
Note that for each project held in the portfolio, a scenario line is created.

Scenario lines
For each project held in the portfolio, a scenario line is created.

A scenario line corresponds to a project line in the source portfolio. It uses the
values of the criteria and lifecycle defined on the project line of the portfolio. It is
used to record the potential decision with respect to the project (validated, rejected)
within the framework of the scenario analysis.

In a scenario, the project portfolio manager can decide to select or not select a given
portfolio line in a simulated scenario (which is different from validation of the
project).

Accepting or Rejecting the Project Lines of a Scenario
A project line must be accepted in order to be taken into account in a given scenario.
Conversely, a project line must be rejected if you want the scenario to ignore it.

To accept or reject a project lines in a scenario:
1. Open the properties pages of the scenario.
2. Select the Characteristics page.
3. In the Scenario Lines section, select the project line you want.
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4. In the Decision column, select one of the following values:
• Accepted: the project line is integrated in the scenario.
• In progress: the project line is under review; it is integrated in the 

scenario
• Rejected: the project line is not taken into account in the scenario

Analyzing and Comparing Scenarios
With embedded reports, you can analyze and compare the scenarios created in a
project portfolio. 

To view these reports:
1. Display the portfolio properties.
2. Select the Reports page.
3. Select the report concerned.

Comparing scenario costs
This report compares the costs of the selected scenarios.

It relates to the project costs, it does not take into account the impact of the
scenario on the operating cost of the applications. 

Project deliverables by scenario
This report details the deliverables included in a scenario; they are classified by
status and whether the projects within the scenario are validated or rejected.

 See Accepting or Rejecting the Project Lines of a Scenario.

In the example below, two deliverables are part of the projects that were accepted
in the scenario; a new CRM application and a server update.

The solution building blocks will thus be created/updated in the scenario.

Analyzing the Road Map for Portfolio Projects
The "Project RoadMap" report displays the Gantt chart for projects and the road
maps for project deliverables.
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To see this report:
1. Display the portfolio properties.
2. Click the Reports page.
3. Select the "Project RoadMap" report.

Project Gantt chart
The Gantt chart presents one row per project. The following information is provided
for each project:

• Start and end dates
• Progress 
• Dependencies
• Declared delays

 See also 
- Follow-up of Ongoing Projects
- Project dependencies.

Roadmap of portfolio project deliverables
The following information is displayed for each portfolio:

• The projects included
• The dependencies
• The status of projects
• The project progress
• The dates defined for the project

 See also Follow-up of Ongoing Projects.

Analyzing the Project Risks of a Portfolio
An embedded report for the project portfolio is used to display, in the form of a
heatmap, the risks inherent to the portfolio projects.

To view this report:
1. Display the properties concerned.
2. Click the Reports page.
3. Select the "Project Portfolio Risk Roadmap".

The heatmap displays the number of risks per risk level (low, high, etc.)

See also: Assessing the Risks of a Project.

Dashboard for Portfolio Projects
This report analyzes the projects included in a portfolio using different graphics.

To launch this report:
1. Display the properties concerned.
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2. In the properties window, click the drop-down list and select the 
Reports page.

3. Select the "Project Dashboard" report.

Project bubble chart
The bubble chart is used to connect the different key indicators of the portfolio
projects.

To define the project indicators to be displayed in the graph:
1. In the X-axis field, select the first indicator, for example, the profit. 

 The profit indicator refers to the financial value. See Project 
benefits.

2. In the Y-axis field, select the second indicator, for example, the total 
cost. 

3. In the Bubble size field, select the third indicator, for example, the ROI.
4. Click Refresh the Report to take the selected data into account.

Project matrix by criteria
For this graph, the parameters selected for report input must be of "enumeration"
type (e.g. Risk level, Business Value Level).

It allows to consult evaluations of a larger number of projects than the bubble graph
(several hundred projects vs. a few dozen).

When you modify the input parameters, you must click on Refresh the Report to
take into account the input data, then click the refresh button of the  chapter to
update it.

Summary table for project assessments
This table presents the latest assessment of the key indicators of the portfolio
project.

See also Assessing a Project.
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Analyzing the Impact of Portfolio Projects on the Architecture
See Impact Reports for Projects.
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HOPEX IT PORTFOLIO MANAGEMENT 
WORKFLOWS

This chapter presents HOPEX IT Portfolio Management workflow diagrams.

 "Application Update Workflow", page 168
 "Technology Validation Workflow", page 169



HOPEX IT Business Management

APPLICATION UPDATE WORKFLOW

Using workflows, Application Portfolio Managers can launch campaigns to update
technical and business information for one or more applications in their portfolios.
These workflows can also be run for all portfolios.

Note that the Application Owners must be correctly specified in the applications for
the workflow to run correctly.

When the campaign is launched, an e-mail is sent to the owners of the application.
It includes the following information:

• List of applications to be updated
• End date of the update campaign (which is set at the end of the month 

following the date of the request. For example: if the request is made on 
September 21, 2023, the end date of the campaign will be October 31, 
2023).

Applications to be updated appear in the list of application to be updated. A reminder
is automatically sent by email fifteen days before the campaign end date. 

Once the application information is updated, the Application Owner submits the
changes to the Portfolio Manager for approval. 
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TECHNOLOGY VALIDATION WORKFLOW

Functional Administrator and Enterprise Architect profiles can initiate the validation
workflow on a technology.

When a vendor is prohibited, all the vendor's technologies automatically change to
"Prohibited" status.

A user holding the role of "Local Correspondent" on a technology can evaluate it and
define it as "Validated", "Accepted" or "Approved". This correspondent must first be
defined in the technology's properties.



HOPEX IT Business Management


	HOPEX IT Business Management
	CONTENTS
	Introduction to HOPEX IT Business Management
	Presentation of HOPEX IT Business Management
	Positioning of the HOPEX IT Business Management solution
	HOPEX IT Portfolio Management
	HOPEX Customer Journey
	HOPEX Business Process Analysis
	HOPEX IT Architecture
	HOPEX for the ArchiMate® Framework


	Connecting to HOPEX IT Business Management
	Connecting to the solution
	HOPEX IT Business Management Profiles

	The HOPEX IT Business Management Desktop
	ITBM Home Page
	Scope Indicators

	Enterprise Architect Desktop

	Preparing the Work Environment HOPEX IT Business Management
	Defining Enterprise Org-Units
	Creating an org-unit
	Specifying org-unit properties

	Defining Categorization Schemas
	Data categories
	Measure Schemes Categorization

	Defining the Process Categories

	Using ArchiMate Diagrams in an Enterprise Architecture solution
	Prerequisites to use of ArchiMate diagrams
	Using ArchiMate Diagrams in an Enterprise Architecture solution
	Creating an ArchiMate Diagram from an EA Building Block
	Creating an Object in the ArchiMate diagram of an EA Building Block
	Adding an existing object in the ArchiMate diagram of an EA Building Block
	Creating a relationship in an ArchiMate Diagram
	ArchiMate element properties in an EA solution

	Management of the ArchiMate model in an Enterprise Architecture solution
	Accessing ArchiMate Models list in an Enterprise Architecture solution
	ArchiMate Models properties
	Defining the default ArchiMate Model for a user

	Managing of the ArchiMate views in an Enterprise Architecture solution
	Accessing ArchiMate Views list
	ArchiMate Views properties

	Synchronizing an ArchiMate Diagram Elements
	Synchronizing an ArchiMate model Elements
	Synchronizing Elements from an ArchiMate diagram using the synchronization wizard


	About This Guide
	Guide Structure
	Additional Resources
	Conventions used in the guide



	Defining the Strategy
	Introduction to strategic transformation
	The HOPEX IT Business Management method
	Identifying Strategic Transformation Elements
	Value Streams and Business Capabilities description
	Defining the enterprise architectures
	Consulting the transformation roadmap
	Defining the Transformation Strategy
	Defining the enterprise and its evolution in time
	Identifying transformation strategic elements

	Describing the Enterprise Capabilty for Creating value
	Describing the Architecture of Business Capabilities
	Describing value streams
	Describing business capability implementation by the business functions
	Identifying Exhibited Business Capabilities

	Describing the Enterprise Architecture
	Describing the business architecture environment

	Consulting the Transformation Roadmap

	Before starting with the strategic transformation
	Defining a Work Context
	Accessing the list of libraries with HOPEX IT Business Management

	Using Properties Pages
	Importing an Existing Breakdown of Business capabilities
	Structure of the import/export Excel template of HOPEX IT Business Management
	Importing the breakdown of business capabilities into an enterprise



	Identifying Strategic Transformation Elements
	Enterprise Strategic Elements
	Creating an Enterprise
	Accessing the list of enterprises with HOPEX IT Business Management
	Creating an enterprise with HOPEX IT Business Management

	Enterprise characteristics
	Connecting the capability map to an enterprise
	Connecting the value stream to an enterprise

	Defining Enterprise Strategic Elements
	Identifying enterprise ends
	Defining Means

	Building an Enterprise Diagram
	Creating an Enterprise Diagram
	Describing the strategic elements


	The strategic elements of a transformation phase
	Defining Transformation Stages
	Creating a Transformation Stage
	Transformation stage properties

	Defining the Strategic Characteristics of a Transformation Stage
	Defining an enterprise objective
	Defining Tactics


	Using performance indicators
	Describing a Measurable Property
	Accessing the list of Measurable Properties of a Library
	Creating a measurable property from a business capability
	The properties of a Measurable Property

	Describing a Qualifying Value
	Accessing the list of Qualifying Values
	Creating a Qualifying Value from an exhibited business capability
	The properties of a Qualifying Value
	Connecting a Measurable Property to a Qualifying Value

	Using sets of indicators
	Creating a Set of Constraining Properties from an object of an enterprise
	Creating a Set of Constraint Values from an exhibited business capability



	Business capability maps and value streams
	Describing a Business Capability Map
	Building the Business Capability Map
	Creating a business capability map
	Creating a business capability decomposition tree
	Creating a capability structure diagram
	Defining capabilities in a capability diagram
	Defining business capability dependencies

	Describing a Business Capability
	Creating a business capability from a business capability map diagram
	Defining the properties of a business capability
	Defining business skills and functionalities associated with capabilities

	Business Capabilities Reports
	Business Capability Map Breakdown Report
	Business Capability Coverage over Time
	Business Capabilities Tree Map


	Describing Value Streams
	Value Stream Example
	Value Stream representation principles

	Using Value Streams
	Accessing value streams
	Creating a value stream
	Creating a value stream diagram

	Representing the Value Stream Implementation

	Describing Functional Coverage
	Describing the Functionality Map
	Accessing the list of functionality maps
	Properties of a functionality map
	Creating a functionality map diagram
	Creating a functionality component in a functionality map diagram
	Defining Functionality dependencies
	Describing functionalities
	Creating a Functionality Diagram

	Describing the Technology Capability Map
	Accessing the list of technology capability maps
	Using the technology capabilities


	Describing Component Fulfillment
	Creating Fulfillment of a Business Capability

	Describing the data of a Business Capability
	Creating a Concept Domain Diagram on the Business Capability
	Diagram Data


	Drawing the Transformation Roadmap
	Identifying Exhibited Business Capabilities
	Managing Exhibited Business Capabilities
	Accessing the list of exhibited business capabilities
	Creating an exhibited business capability
	The properties of an exhibited business capability
	Stages Capabilities Synthesis report

	Using Assessment for Business Capabilities and their Implementation
	Creating a business capability assessment
	Creating an assessment of business capability implementation


	Describing a Business Architecture Environment
	Managing a Business Architecture Environment
	Accessing the list of Business Architecture Environments
	Creating a business architecture environment
	The properties of a business architecture environment
	Creating a business architecture environment diagram

	Describing a Business Functional Area
	Accessing the business functional area list
	The properties of a business functional area
	Describing a business functional area diagram
	Managing service points and request points
	Managing Service Interactions

	Describing Business Functions
	Accessing the list of business functions
	Business properties

	Describing Business Partners
	Accessing the business partners list
	The properties of a business partner


	Describing an Enterprise Architecture
	Describing the operating architecture
	Describing physical solutions

	Drawing up the Roadmap


	Managing IT Assets
	Drawing up an Application Inventory
	Drawing up a Technology Inventory
	Managing the Data Used in the Application Assets
	Evaluating Application Assets
	Importing Objects in HOPEX IT Business Management
	Downloading the Excel Import Template
	Template description


	Project Portfolio Management
	Introduction to Project Portfolio Management
	The Scope Covered by PPM
	Prerequisites for Creating Projects
	Importing the PPM module
	Defining project domains

	Managing Project Demands and Candidate Projects
	Identifying and documenting demands
	Assessing demands
	Validating demands
	Assessing candidate projects
	Validating candidate projects
	Following-up ongoing projects

	Project Portfolio Management
	Selecting the projects and defining priorities
	Analyze and arbitrate portfolio projects


	Roles in HOPEX Project Portfolio Management

	Defining Enterprise Projects
	Defining Project Domains
	Creating a Project Domain
	Assigning a Domain to Persons

	Managing Project Demands
	Demand Management Process
	Creating a Project Demand
	Defining the Project Charter
	Defining the Business Case of a Project
	Transformation objective
	Project deliverables
	Project dependencies
	Project costs
	Project benefits
	Project risks

	Assigning a Project to Persons
	Validating or Rejecting a Project Demand
	Validating a project demand
	Rejecting a project demand


	Managing Candidate Projects
	Candidate Project Management Process
	Creating a Candidate Project
	Completing the Candidate Project Definition
	Validating or Rejecting a Candidate Project
	Validating a candidate project
	Rejecting a candidate project


	Assessing a Project
	Assessing a Project
	Assessing the Risks of a Project

	Follow-up of Ongoing Projects
	Process for Follow-up of Ongoing Projects
	Starting a project
	Specifying the Project Milestones
	Assessing the Progress State of a Project
	Updating the project progress
	Viewing the timeline of a project

	Putting a Project on Stand-by/Canceling a Project
	Terminating a Project

	Project Analysis Reports
	Reports on the Project Content
	Project Costs
	Project and Deliverable Timeline Gantt Chart
	Project KPIs
	Project summary

	Impact Reports for Projects


	Project Portfolio Management
	Grouping Projects by Portfolio
	Portfolio Types
	Arbitration portfolio
	Analysis portfolio

	Portfolio Lines
	Assigning a Portfolio to Persons

	Assessing Portfolio Projects
	Defining Portfolio Assessment Criteria
	Criteria weighting model

	Creating a Project Assessment
	Assessing common criteria
	Assessing criteria specific to the portfolio


	Analyzing and Arbitrating Portfolio Projects
	Creating a Scenario
	Defining the properties of the scenario
	Scenario lines

	Accepting or Rejecting the Project Lines of a Scenario
	Analyzing and Comparing Scenarios
	Comparing scenario costs
	Project deliverables by scenario

	Analyzing the Road Map for Portfolio Projects
	Project Gantt chart
	Roadmap of portfolio project deliverables

	Analyzing the Project Risks of a Portfolio
	Dashboard for Portfolio Projects
	Project bubble chart
	Project matrix by criteria
	Summary table for project assessments

	Analyzing the Impact of Portfolio Projects on the Architecture



	HOPEX IT Portfolio Management Workflows
	Application Update Workflow
	Technology Validation Workflow


